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About This Book

Purpose

This guide describes how to use the Novell Integration Manager Connect for PeopleSoft®. This product
has design-time as well as runtime executables and uses Java Connector Architecture technology to
provide integration capability.

Audience

This book is for developers and systems integrators who are planning to use Novell Integration Manager
to develop PeopleSofte-aware services and components.

Prerequisites

This book assumes prior familiarity with Integration Manager’s work environment and deployment
options. Some familiarity with PeopleSoft® is also assumed. Familiarity with Java Connector
Architecture is helpful but not required.

Software Versions

This guide assumes that you are using Novell Integration Manager (Enterprise or Professional) version
5.2 (or higher) and that you are deploying your applications to a J2EE 1.3 application server or
equivalent.

The Connect for PeopleSofte is designed to work with PeopleSofte 8.1 or 8.4.

NOTE: You will need to obtain psjoa.jar from PeopleSoft in order to complete the installation of your
software. This file is proprietary to PeopleSoft and is not shipped nor installed with Integration Manager. If
this file is not already on your file system as part of your PeopleSoft installation, contact your PeopleSoft
representative to obtain it.

Additional documentation

For the complete set of Novell exteNd documentation, see the Novell Documentation Web Site
(http://www.novell.com/documentation-index/index.jsp).

About the Product Name Change

In version 6.0. we've changed the name of exteNd Composer to Novell Integration Manager. In some
places in the user interface, and in Integration Manager file and directory names, you will still see the
name "exteNd Composer" or "Composer".


http://www.novell.com/documentation-index/index.jsp
http://www.novell.com/documentation-index/index.jsp
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Welcome to Novell Integration Manager
Connect for PeopleSoft:

Welcome to the Novell Integration Manager Connect for PeopleSoft® User s Guide. This Guide is a
companion to the Novell Integration Manager User s Guide, which details how to use all the features of
Integration Manager except for the Connect Component Editors. So, if you haven’t looked at the Novell
Integration Manager User s Guide yet, please familiarize yourself with it before using this Guide.

Novell Integration Manager provides separate Component Editors for each Connect, including the
Connect for PeopleSoft®. The special features of each component editor are described in separate Guides
like this one.

If you have been using Integration Manager and are familiar with the core component editor (the XML
Map Component Editor), then this Guide should be enough to get you started with the PeopleSoft
Component Editor.

NOTE: To be successful with this Component Editor, you should already be familiar with PeopleSoft and
basic XML integration concepts.

About Novell Integration Manager™

Novell Integration Manager is an XML integration-broker. It encompasses a set of design tools for
building XML integration applications and web services, plus a runtime engine that enables execution
and administration of the services you build. The applications and services you build with Integration
Manager can be deployed to any popular J2EE application server or servlet container. (Supported servers
include JBoss, IBM WebSphere and BEA WebLogic in addition to the Novell exteNd application server.
Tomcat is also supported. Be sure to consult the Novell web site for latest platform-support information.)

At the core of Integration Manager is a robust XML transformation engine capable of performing a wide
range of data transformations, including joining of multiple documents, decomposition of documents,
and/or creation of entirely new documents on the fly. The underlying enabling technologies include not
only XSLT but XPath, ECMAScript, and Java. Integration Manager’s design environment offers a rich,
intuitive graphical user interface, making it possible for you to specify XML transformations and
mappings visually, using wizards, dialogs, and drag-and-drop gestures. You never have to write raw XSL
or Java code.

Integration Manager supports numerous kinds of data-source connectivity, through individual adapters
called Connects. Using the functionality exposed in the various Connects, you can design EAI
applications and/or web services that pull data in from or push data out to a variety of different kinds of
back-end systems, using a variety of transport protocols and technologies, ranging from 3270 and 5250
terminal data streams to Telnet, HP3000, Unisys T27 (and UTS), Tandem, Data General, etc., in addition
to HTML screen-scraping, JMS messaging, and CICS RPC transactions. You can also take advantage of
JDBC, LDAP, and other mechanisms to reach back-end data repositories and systems that might or might
not natively understand XML. Integration Manager Connects allow you to connect to these systems
inobtrusively, so as to marshall non-XML data into XML form or vice versa without any need to modify
host-system setups or code.

Welcome to Novell Integration Manager Connect for PeopleSoft® 9
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In addition to legacy data-stream and protocol-specific Connects, Integration Manager has Connects for
ERP and CRM systems, including Baan, PeopleSoft, SAP, Siebel, Lawson, JD Edwards, and Oracle
Financials. As with other Connect solutions, the ERP and CRM Connects are fully integrated into
Integration Manager’s design-time environment so that you can use intuitive visual tools to create
powerful custom integration solutions, eliminating the need to write Java code or edit raw XML or
schemas by hand. You can also test the components you build against live PeopleSoft connections, using
the design environment’s animation facility (step-through debugger). As part of the design and debug
process, your PeopleSoft-aware components can call other Integration Manager Components (such as
XML Map Components, JDBC Components, etc.) and make use of any of the core actions that
Integration Manager defines (such as Map, Function, Log, and other actions).

About the Integration Manager Connect for PeopleSofte

The Novell Integration Manager Connect for PeopleSoft® allows you to leverage PeopleSoft’s
Component Interface technology to build powerful XML-based integration solutions.

The Integration Manager Connect for PeopleSoft® enables you to access a PeopleSoft component using
the Component Interface mechanism provided by PeopleSoft. (Here, “PeopleSoft component” means a
component defined by the PeopleSoft API, not a Integration Manager xObject.)

You do not need to manually generate or install PeopleSoft XML schemas in order to use the Integration
Manager Connect for PeopleSoft®. The Connect will generate schemas for you, as needed,
automatically.

You also don’t have to take any steps to preinstall RARs (resource adapter archives, defined by the Java
Connector Architecture) on the target application server ahead of time. Integration Manager handles
RAR deployment for you automatically when you deploy any Integration Manager-built service that
utilizes the Integration Manager Connect for PeopleSoft®.

NOTE: Some one-time setup and configuration steps are required in order to use the Integration
Manager Connect for PeopleSoft®. The steps in question are described in detail under “Setup and
Configuration” in the next chapter.
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About J2EE Connector Architecture

The J2EE™ Connector Architecture defines a standard architecture for connecting elements of the J2EE
platform to a heterogeneous Enterprise Information System (EIS). Examples of EIS components include
(typically) Enterprise Resource Planning (ERP) systems, Customer Relationship Management (CRM),
Supply Chain Management (SCM), mainframe transaction processing, database systems, and legacy
applications that are not written in the Java programming language. By defining a common set of
scalable, secure, transactional mechanisms reachable via a standard set of APIs, J2EE™ Connector
Architecture enables the integration of an EIS with an application server and enterprise applications.

The J2EE Connector Architecture permits an EIS vendor to provide a standard resource adapter for its
EIS. The resource adapter plugs into an application server, providing connectivity to an EIS, and
integrating it with the rest of the enterprise. If an application server vendor has extended its system to
support J2EE™ Connector Architecture, it is assured of seamless connectivity to multiple Enterprise
Information Systems.

Before J2EE™ Connector Architecture, most EIS vendors offered vendor-specific architectures to
provide connectivity between applications and their software; each program interacting with an EIS
needed to be hand-tooled by someone with a detailed knowledge of the peculiarities of the target EIS.
Custom software to do this across multiple systems was time consuming to develop, debug, and maintain.

By providing a standard set of APIs and contracts for managing connectivity, exposing EIS APIs, and
using application-server services (like transaction control and connection pooling), J2EE™ Connector
Architecture greatly reduces the need for custom programming. Developers can focus on business logic
rather than connectivity and transaction-related logic and a variety of “plumbing issues.”

How J2EE™ Connector Architecture Works
The “major participants” in J2EE™ Connector Architecture include these components:

+ Application server
+ Resource adapter (RAR)
+ Application

The application server is not strictly required. Certain services like connection pooling and transaction
control will not be available in a “server” that is just a servlet container. But J2EE™ Connector
Architecture resource adapters can still operate.

The RAR represents the interests of the underlying EIS.

The application interacts with the resource adapter using what J2EE™ Connector Architecture calls
standard contracts. Standard contracts define what interactions are to take place and how they are
exposed. The contract between the application and the resource adapter is called the Common Client
Interface (CCI). The resource adapter, in turn, interacts with the application server under the Service
Provider Interface (SPI), which defines how the management of resource adapter interactions occurs.
The aspects of this include:

+ Connectivity management

+ Transaction demarcation

+ Event listening (listeners can receive notification of significant events; for example, a connection
failure)

+ Pooling of connections and other resources

In the normal course of events, the application uses a naming service to locate the appropriate resource
adapter. The application server supplies the naming service, and so it recognizes that a request is being
made to locate a resource adapter. In such a case, the application server interposes a resource-adapter-
supplied intermediate object that interacts between the resource adapter and the application server.
Through this intermediating object, the application server manages the items within the SPI contract
below the awareness of the application.
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For more information about J2EE™ Connector Architecture, visit http://java.sun.com/j2ee/connector/.

About iWay Technology

Novell Integration Manager uses licensed J2EE™ Connector Architecture adapter technology from iWay
Software (a division of Information Builders, Inc.) to mediate EIS interactions in the Integration Manager
Connect for PeopleSoft®. A leader in the J2EE™ Connector Architecture technology space, iWay
Software provide resource adapters and connectivity solutions across a wide array of EIS and other
systems.

For more information about iWay, see http://www.iwaysoftware.com.

What Kinds of Applications Can You Build Using the Integration
Manager Connect for PeopleSoft:?

12

With Integration Manager Connect for PeopleSoft®, you can build any kind of web service or integration
application that needs to push data into or pull data from a PeopleSoft-based data store using XML as the
interchange format. Your integration application can be deployed to a J2EE application server and run as
a public web service, or it can be used in “behind the firewall” scenarios. It can be triggered by a servlet,
JSP, EJB, e-mail, timer, file arrival, JMS message arrival, or programmatically via your own custom
code. It can also run standalone or as part of a workflow built using Integration Manager Enterprise
Edition’s Process Manager. (For more information on deployment options, see the deployment chapter of
the Novell Integration Manager User s Guide.)
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Getting Started with the Integration Manager
Connect for PeopleSoft:

This chapter discusses software setup and configuration issues relevant to using the Integration Manager
Connect for PeopleSoft®, as well as the steps needed to create a Integration Manager Connection
Resource for a PeopleSoft® Component.

Setup and Configuration

A number of steps must be taken before you can use the Integration Manager Connect for PeopleSoft®.
You must, at a minimum:

1 Put copies of the PeopleSoft Java Object Adapter (psjoa.jar) on design-time and runtime
(application server) machines. See “Putting psjoa.jar in the Classpath” on page 14.

2 Deploy the supplied remote interfaces (Component Interfaces). See “Deploying the PeopleSoft
Component Interface Files” on page 15.

3 Generate PeopleSoft Component Interface API classes, package them in a JAR, and put the JAR on
design-time and runtime machines. See “Building PeopleSoft Component Interface API Classes”
on page 24.

4 Update classpath entries in xconfig.xml (design environment) as well as on the server, to reflect
addition of new JARs. See (again) “PeopleSoft Java Object Adapter” on page 13.

5 Update the license for your Integration Manager Connect for PeopleSoft® installation, as needed.
See “Updating and/or Activating Your License(s)” below.

6 Create new component interfaces for PeopleSoft services that you wish to expose. See “How to
Create a New Component Interface” on page 61 in Appendix B of this guide.

The steps necessary to accomplish these requirements are discussed in detail in the following sections.

PeopleSoft Java Object Adapter

Before attempting to use the Integration Manager Connect for PeopleSoft® (which is installed
automatically as part of the Integration Manager installation process), you must complete the installation
by obtaining and installing the psjoa.jar file, which comes from PeopleSoft®. This file is proprietary to
PeopleSoft® and is not shipped by Novell nor installed with Integration Manager.

The psjoa.jar file may already exist on your PeopleSoft Application Server under the
PS_HOME/Web/psjoa directory. If not, contact your PeopleSoft representative to obtain a copy of this
file.

When you have located the psjoa.jar file, you must add it to your design-time classpath as well as your
runtime-environment classpath (typically the application server classpath). The procedures for doing this
are given below.

Getting Started with the Integration Manager Connect for PeopleSoft® 13



Putting psjoa.jar in the Classpath

The PeopleSoft Java Object Adapter (psjoa.jar) must be added to your design-time and runtime
environments before you can use the Integration Manager Connect for PeopleSoft®.

> To add psjoa.jar to your design-time configuration

1

2

7

Determine the version number of your existing PeopleSoft system. It should conform to version 8.1

or 8.4. These are the only versions currently supported by Novell Integration Manager.

If Integration Manager is running, shut it down before proceeding.

Obtain psjoa.jar from PeopleSoft® if it is not already included in your preexisting PeopleSoft

installation®.

Copy psjoa.jar to the /Common/lib folder of the Integration Manager installation directory on

your design-time machine.

+ In this folder, you should also see files called pstools.properties and iwpeoplesoft.jar. If these
files are not present, contact Novell customer support to obtain them.

Ensure that the JAR files are on your design-time CLASSPATH. To do this: Locate your
xconfig.xml file under /Composer/Designer/bin and open it in a text editor. Scroll to the bottom.
Within the <RUNTIME> element, you should see many <JAR> entries. Add an additional <JAR>
element as follows:

<JAR>..\..\..\Common\lib\psjoa.jar;..\..\..\Common\lib\iwpeoplesoft.jar;..\..\..\C
ommon\lib\psGenComp.jar;..\..\..\Common\lib\pstools.properties</JAR>

This entry essentially tells the classloader where it can find four files:
+ psjoa.jar—This is PeopleSoft’s own Java Object Adapter jar (which ships with PeopleSoft)
+ iwpeoplesoft.jar—Comes with Novell Integration Manager installation.

+ pstools.properties—This file is not an absolute requirement but will prevent certain exceptions
from being thrown in the background.

+ psGenComp.jar —You will need to generate this JAR yourself according to the procedure
described at “Compiling the Component Interface Files” on page 26 further below.

In xconfig.xml, verify that a <JAR> entry exists, referring to iwpsci81.jar if you are using
PeopleSoft 8.1, or iwpsci84.jar if you are using PeopleSoft 8.4. (These files are installed as part of
the Integration Manager installation.)

CAUTION: Only one of these JARs should be on the classpath. Do not allow both JARs to be
referenced in xconfig.xml, as this will cause unpredictable behavior.

Save xconfig.xml and close it.

> To add psjoa.jar to your Novell application server environment

1

2

Obtain psjoa.jar from PeopleSoft® if not already included in your preexisting PeopleSoft
installation®.

Copy psjoa.jar to a suitable location on your application server. The exact location doesn’t matter
as long as you create a CLASSPATH entry pointing to it, as described in the next step.

Update the application server CLASSPATH. For the Novell exteNd application server, locate the
AgJars.conf file under the AppServer/bin directory. Under “MODULE COMMON?” create a new
pair of entries:

$SS LIB ../../Common/lib/psjoa.jar
$S8S LIB ../../Common/lib/psGenComp.jar

(This example assumes that you have placed the JAR files under /Common/lib. Edit as necessary
to reflect the actual target directory.)

NOTE: For application servers other than Novell exteNd, follow the application server vendor’s
instructions for updating the classpath.
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Also verify that an entry exists for iwpsci81.jar or iwpsci84.jar (as appropriate to the version of
PeopleSoft you are using). Do not allow both JARs to have entries, as this will cause unpredictable
behavior. These files are installed as part of the Integration Manager installation. You do not need
to obtain them from a third party.

Deploying the PeopleSoft Component Interface Files

Before you can use the Component Interface APIs discussed in “Building PeopleSoft Component
Interface API Classes” on page 24, you must expose the supplied component interface files to your
PeopleSoft system. This is not done by the Integration Manager installation program (because the
location of your PeopleSoft system and the file-write permissions in that system are not known at install
time, and in any case this step requires manipulation of the files using PeopleSoft’s Application
Designer). The files that you need to deploy are contained in a zip archive called iwpsci84.zip (if you are
using PeopleSoft 8.4) or iwpsci81.zip (if you are using PeopleSoft 8.1), which are included in the
Integration Manager install in the NIM6\Composer\Designer\lib directory (Windows) or
nim\Composer\Designer\lib (Linux). The discussion that follows applies to PeopleSoft 8.4.

You will need to deploy the files in this archive to PeopleSoft (not to the application server) in order to
enable introspection of the PeopleSoft Component Interfaces by the middle-layer adapters that
Integration Manager relies on to support interaction with PeopleSoft. The following procedure describes
how to do this.

Importing and Building the Component Interfaces

> To import and build the Component Interface files

1 Copy the iwpsci84.zip or iwpsci81.zip from NIM6\Composer\Designer\lib directory (Windows) or
nim\Composer\Designer\lib (Linux) to an empty directory of your choice (e.g.,
C:\temp\PSProjects), then expand the zip file. This creates a sub-folder called IWY CI 84 (which
contains 2 files) or IWNY _CI_81 (which contains 21 files).

2 Launch the PeopleSoft Application Designer in two-tier mode.

3 From the PeopleSoft Login Screen, select the Connection Type dropdown and select the
appropriate database for your system (e.g., Oracle).

4 Log on using your ID/password.

Getting Started with the Integration Manager Connect for PeopleSoft® 15
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6 In the file-browsing dialog that appears (see the following illustration), navigate to your unzipped
project directory and select IWY CI 84 or IWY CI 81.
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7 Click the Open button. The project appears in the Project Workspace and there is output in the

Output Window. Make sure that all the objects listed under Object Types are highlighted, and then

click Copy.
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The Application Designer displays an “Upgrade Copy ended” message in the Output Window to
indicate successful completion.

8 Next, we will build the views in the project by choosing Build > Project from the main menu.
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9 Check the Create Views checkbox from Build Options. (See the following illustration.) Under
Rule Execute Options, select the Build Script File radio button.
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You may want to click on the Settings... button to verify that “Recreate view if it already exists” is
checked, then return to the Build dialogue box.

10 Click Build.
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11 Verify in the Upgrade tab (at the bottom of the main window) that the view built correctly.

NOTE: If the view has not been generated correctly, close the dialog and double-click the SQL
Build log.
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Configuring Component Interface Security

You must ensure that all Application Explorer users have access to the Component Interfaces that you
deployed and built in the previous sections. As with all PeopleSoft objects, security is assigned at the
Permission List level. Review your site security requirements to determine which users are going to work
with Integration Manager, and then set Component Interface security for each distinct Permission List
belonging to those users.

NOTE: These Component Interfaces have only Get and Find access and cannot be used to update your
PeopleSoft database. This minimizes any possible security exposure.

In PeopleSoft release 8.1, you may set security in 2, 3, or 4-tier mode; in release 8.4 and higher, you may
set security 4-tier mode only.

The following procedure describes how to configure security for all supported releases of PeopleSoft in
all supported modes. The figures shown in the steps are from PeopleSoft release 8.4 in 4-tier mode.

> To configure security for each Component Interface:

1

Choose PeopleTools, Security, User Profiles, Permissions & Roles, and then Permission Lists.

= Becurity

[» User Profiles

= Permissions & Roles
= Permission Lists
= Copy Permission Lists
= Delete Permission Lists
= Roles
= Copy Boles
= Delete Roles

= Exgcute Role Rules

D

Select Search and select the relevant Permission List. The Permission List pane opens on the right.

| i Permission Lists - Microsoft Internet Explorer

Fle FEdt Vew Favortes Tools Help |

Gagack - = - D [2] 4| Qoearch [CaFavortes (HHsory | BN S w5 B] @

adiress [ e b OVEE/ERP/c/MAINTAIN_SECUIRITY,ACCESS_CNTRL LISTX GEL =l @eo ‘

b Tree Manager |
b Reporting Tools
vasegﬂfmf“‘ﬁ Permission Lists

b User Profiles Enter any informatian you have and click Search. Leave flelds blankTor a list ofall values.

~ Permissions & Roles
- P ists

New Window | Help &

{ Find an Existing Value \_Add @ New Value

- Copy Penmission Lists
= Delete Permission Lists
- Rales

Search by: [Permission List =] begins with|

- CopyRoles
- Delete Roles Search | Agvanced Search

- Execute Role Rules

P Directory Search (Al+1)
b Security Objects Search Results
P Query Security
= Review Security

Only the first 300 results can be displayed. Enter more infarmation above and search again fo reduce the number of search results

Infartaation Yiew Al 190 01300 [§] Last
IE \;"D”r"":“”‘” AEAET000 Enviranments Managerment
b Sesrch Engine AEPNLS AEPNLS: clane of ALLPRLS
b Persanalization ALLPAGES  ALLPAGES
b Process Scheduler ALLPORTL Al Partal
» Cube Manager AMPNLS (blank)
b Application Engine
I Integration Broker AMBYSTEM  (blank)
b Tl Configuration APPNLS (blank)
b archive Data APPSRVE Can start application server
'; 'Er;“";:;:g; BOPNLEA (blank)
I Mass Changes BOPNLES (blank)
- Change My Password BIPNLS Billing Panels
- My Personalizations. CPAE1000 Application Enviranment

- ity System Profile

CPEQ1000 Enterprise Objects

=

[&] javascript: submitéction_main(document. main, '#ICRowd'; [ [ [ mtemet

3 Click the right arrow next to the Sign-on Times tab to display the Component Interfaces tab.

Getting Started with the Integration Manager Connect for PeopleSoft® 19



20

4

File Edt Wiew Favorites Tods  Help

daback + = - (@D [F] G}| Qusearch (GgFavorites {BHstory |

Address W hittp: ffisdsr1 4. ibi.com/pspins[EMPLOYEEYERP e MAINTAIN_SECLRITY ACCESS_CNTRL_LISTR GEL

%.
s € |

D Tree Manager

I Reporting Tools

< PeopleTools

= Security

b User Profiles

~ Permissions & Roles
Li

opy Permission Lists
- Delete Permission Lists
- Roles

- Delete Roles
- Execute Role Rules

NevWindow | Hel

[ General | Pages | Peoplelools | Process | Sign-on Times | [V)

Permission List Al PAGES

Description: ALLPAGES
Permission List General

Navigater Homepage: [rsacaToR

[ Can Start Application Server?

b Directory

b Security Objects

b Query Security

- Review Security

Infarmation

b Utilities
b Warkdlow
b Portal
b Search Engine
b Personalization
b Process Scheduler
P Cube Manager
I Application Engine
b Integration Broker
b CTl Configuration
b Archive Data

b Translations

b EDI Manager

P Mass Changes
- Change My Password
- ity Personalizations
- by Systerm Profle

I™" allow Password to be Emailed?

Time-out Minutes

& Never Time-out
 Specific Time-out (minutes)

B)ssve) (QRetum to Search) (+ENextinList) [ 1 Previous inList) Beroa) ()

General | Pages | PeopleTools | Process | Sian-on Times | Comaonent Interfaces | Message WManitor | Web Lisraries | Personalizations | Query | Mass ¢

&1 oone

Fle Edk View Favorites

icrosoft Internet Explorer

[ [ tneemes

Click the Component Interfaces tab.

Tooks  Hefp

<= Back

DA & Qoeach [BiFavories CHistory | B b W 5 ] @

Auress [B epfisdsro L4,

EEERPCIMAINTAIN_SECLRITY ACCESS_CNTRL_LISTH /GEL

%.
[Er—C

b Tree Manager
P Reporting Tools
v PeopleTaols
~ Security

D User Profiles

~ Permissions & Roles

Capy Perrission Lists

£ Home iork S Add o F

NewWindow | Help

] { Sign-on Times _j” Component Interfaces | Mgssage Monitor | Web Libraries |
Permission List  ALLPAGES

Description ALLPAGES

N W IComponent Interfaces Fi [
- Copy Roles [Name Edit
= Delete Roles AP_PCJOB_ROST Edit =]
- Execute Role Rules N
b Directory AP_PCI0B_ROSTZ Edit =]
b Security Objects AR_CONVERSATION_AGENT Edit =]
D Query Security
- Review Securi AR_CREDIT_AGENT Edit [+
Information AR_ITEM_AGENT Edit =]
b Utilties
b Warkiow AUC_BID_CONTACT_CI Edit =]
b Portal AUC_CREATE_CLONE_CI Edit +]| =
b Search Engine = = = = L=
b Persanalization 4UIC_CREATE_PO Edit =l
l; ETJS?AZ%ZZ?“‘” AUC_PAGELET_PREF_CI Edit JE3 pe|
b Application Engine AUC_VINDR_ID_CI Edit =]
b Integration Broker
|-
b GTI Configuration A5 APPR_O! Eait F =
b Archive Data BDG_CNTRL_EW_NTFY Edit +=]
b Transiztions
+|[=
b £l Monsaer BDG_CNTRL_NOTIFY Edit JE3pe|
b Mass Changes BD_ACCT_PER_LOOKUP Edit =]
- Change by Password =
- iy Personalizations BD_ANALYSIS_DB Edit EH=
- My System Profile BD_ASSET Edit +1 -1
2Kl |

&

[ [ |4 trtemer

5 To add a new row to the Component Interfaces list, select the plus sign (+).
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Lists - Microsoft Internet Explorer

& . s P ]
Back Forard| Stop  Fefresh  Home Search Favorites  History Mail Print Edit Discuss AM

Adchess [ @] ity /7odsn 151 comipep/po EMPLUYEE/E RP/o/MAINTA_SECURITY ACCESS_CNTAL_LISTR GBL

-

-

an ou
b Reporting Tools =] Mew Window | Help &
~ PeopleTools
~ Security (4] [ Gign-on Times | Component iterfaces (_ Message Monitor 3 Wieh Likraries | [»)
b User Prafiles
hodlal Sl n List: ALLPAGES

Copy Permission Lisis ALLPAGES
- Delete Permission Lists
jggmoles (Component interfaces:
- Copy Roles
- Delete Roles
- Execute Role Rules AP_PCJOB_ROST Edit +] =
P Directory
D Seeuity Objects @ Eat JEa pa|
P Query Security
AP_PCJOB_RQST2 Edit +] =
- Review Security - - Edt ==l
Infarmation AR_GC ONYERSATION_AGENT Edit + I -
P Utilities —
[ Qv AR_CREDIT_AGENT Edit ==
P Portal AR_ITEM_AGENT Edit + I =
b Search Engine
b Poromaiation AUC_BID_CONTACT_CI Edit JE B
b Process Scheduler AUC_CREATE_CLONE_CI Egit +] =
b Cube Manager
b Application Engine AUC_CREATE_PO Edit +] =
b Integration Broker AUC_PAGELET_PREF_CI Edit +] =
b Tl Configuration
b Archive Data AUC_VNDR_ID_CI Edi =1
P Translations AUC_WF_APPR_CI Edit _l"‘ _I_
P EDI Manager
P Mass Changes BDG_CNTRL_EW_NTFY Edit ll ;‘
- Change Wy Paseword BDG_CNTRL_MOTIFY Edit +] =
= Mty Personalizations
- Wiy Svstem Profile IED,ACOLPER,LOOKUP Eut F1[-] | b4
>« »
[T [ [ intemet

&) Done

6 Enter or select the IWY_CI ATTRIBUTES Component Interface and select Edit.

73 Permission Lists - Microsoft Intemet Explorer

Fle Edt \Miew Favortes Help
N B 5 #

Back  Fuuad  Glop  Rellesh Home | Seach Favories Histoy | Mal  Pinl  Fof  Dieeuss Al

Address [&] ripsdsrts OVEE. TAIN_SECURITY ACCESS_CNTRL_LISTX.GAL =] @6e

% Home

b Reporting Taols 2l MewWindow | Help
= PeopleTools
~ Security Component Interface Permissions

P User Profiles

IW7_CI_ATTRIBUTES

i Companert Interface Custornize | Find | N [l Access )
Delete Fermission Lists e MHnos Ik
No Access (Al)

- Roles
- Copy Roles Method

- Delete Roles et

= Execute Role Rules
b Directory Find Full Access k3

b Security Objects
b Query Security
- Review Security
Infammaation

b Utilities 0K Carncel
P wiorkflow

b Fortal

P Search Engine

b Personalization

P Process Scheduler
B Cube Manager

P Application Engine

B Integration Broker

P CTI Configuration

B Archive Data

P Translations

I EDI Manager

P Mass Changes
- Chanie My Passwiord
- iy Personalizations
- by Systerm Profile

[&] Done

I [ Intemet

7 To set the Get and Find methods to Full Access, select Full Access (All).

Select OK.

Repeat steps 5 through 8 for the IWY CI MESSAGES Component Interface.
10 Scroll down to the bottom of the Component Interfaces window and click Save.

You have finished configuring security for the Component Interfaces delivered with Integration
Manager. To test these Component Interfaces, see “Testing the Component Interfaces” on page 21.

Testing the Component Interfaces

You must test each of the Component Interfaces that were created and secured in the previous sections
before using them.
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> To test the Component Interfaces:
1 In PeopleSoft Application Designer, open the IWY _CI_ATTRIBUTES Component Interface.

2 Sclect Tools, and then Test Component Interface. The Component Interface Tester dialog box is
displayed.

] Application Designer - IWY_CI_84 - IWY_CI_ATTRIBUTES (Component Interface)
Fie Edit View Insent Buid Debug Took Go Windaw Hel

MEEENE R =R

&) v _CI_B4
=R= et terface B e RIEUTES (Comper | Name Record
MWy _CI_ATTRIBUTES ICDEFN [Table] - Searoh (' R TIWY_CIATTHIBUT.

i 8 MY_CI_MESSAGES & oroll-Level O =& GETKEYS

-0 Companents B [ Soroll-Level 1 Primay | @ BONAME PSBCDEFM
] Pages =&y FINDKEYS

{2 Recods HI T poncnEE BowayE
56 Component Inteiface Tester - Enter key values. choose function

BCNAME

- Get' keys for Componsnt lick

[es BCriaNE I | Gel Existing |

(= Stea= Reys for Gomp orient )

Greste =y

|- Find' keys for Component Interface [double-click to set)

[@o BENANE I ] Find

¥ Irteractive Mode [set propertias immediately)

I™ GetHistorp ltems. Cancel

™ Edit History ltems

3 Deveropment [£ Upgraie

Begin validating Companent Interface integriy =
Mo errors foun
End Component Intsiface vaidation

B Bld  Unorade s Resills ) Ualicte
=) FeeoDMO [ | I

NOTE: The Create New option is disabled because the Add method is not applicable to this
Component Interface.

3 Click Find. Entries for the underlying component are displayed.

NOTE: A message may appear stating that display is limited to a certain number of entries; this is
not a problem.

~J Application Designer - WY_CI_84 - 'wWY_CI_ATTRIBUTES (Component Interface)
File Edt View lnset Buid Debug Tools Go window Help

D|=58] 8| &= 5

FRAE]
423 Component Interface
T B8 furv_CLATTRIBUTES
PwY_CI_MESSAGES
(] Components
O Pages
3 Records

. e
3 saL Comporent Interface T oster - Find Rosults =]

felick
USER_PROFILE =] [fSetScicied]
VCHR_APPROVE Cancel

VENDOR_USER_

=8 IWY_CI_ATTRIBUTES [Component Interface) =

BENAME
Iwv_CI_ATTRIBUTES [203]
BCNAME
Iwv_C_ATTRIBUTES [204]
BCNAME
Iw_CI_ATTRIBUTES [205]
BCNAME VNDR_ID
Iwv_CI_ATTRIBUTES [208]
BCHAME WF_MONITOR_S.

Iwv_C_ATTRIBUTES [207]
B

WF_TIMEOUT_D.
Iw_CI_ATTRIBUTES [208]
BONAME WORKER_BID
Iwv_C_ATTRIBUTES [209]
WORKLIST

BCNAME
Iwr_CI_ATTRIBUTES [210]
BCNAME

=
WORKLISTENTR =]
Kl e[|

Begin valdating Component Intsiface integity =
Mo errars foun
End Component Interface validation

S5 T\ B 1 Ungrade i Resus 1 Vatidate
Feady FeDMO [T

4 Highlight one of the lines with its corresponding key in the Find Results window and click Get
Selected. The relevant data for the selected key is displayed.
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[ Application Designer - IWY_CI_B4 - IWY_CI_ATTRIBUTES [Component Intesface)

Fie Edi Vew Inset Buld Debug Tools o Window Help

= EENE R EE TR

T oot 4 IWY_CI_ATTRIBUTES (Companent Interface) o]
£-23 Component nterface 1v4_C_ATTRIBUTES [Compo [ Name Record Field Re_| 0o
: Iw_C|_ATTRIBUTES ) PSBLDEFN [Table) - Searc [ @ TWY_CIATTRIED
: IwY_CI_MESSAGES B sciol - Level 0 = SoTecve

(3 Componerts ompanent Interface Test

(] Pages Live Componert View. Double-click to change values, Flight click t execute methods.

8 E;ims Item Name Valie =
EE- ]
=& GelkeylnioColecton
- G BONAME LOCATION
=8 FindKeyirfoCollection
o BONAME LOCATION

6D IWY_PSBCITEM W

& lw_PSBCITEM Vi [1]
IWY_PSBCITEM W [2]
I PSBCITEM Wi [3]
IW_PSBCITEM_ W [4]
IWY_PSBCITEM_ v [5]
I PSBCITEM Wi [E]
IWY_PSBCITEM W [7]
IWY_PSECITEM_ W [8]
Iw_PSBCITEM Wi [3]
IWY_PSBCITEM Wy [10]
1w PSBCITEM Vi [11]
1WY_PSBCITEM W [12]

+ 1wy PSREITFM Vi 1131 =
1| | 3

Error Message Log

] pevclopment

B ogn validating Componert Interface egily =
Mo enars found
End Companent Interface vaidation

AT Buid_A_Upyrade J\ Resuls ), Validate

Feady FaoMo [

If this window is displayed, the Component Interface has been successfully tested for the Find
method.

Click the Get button. For the Get method, an existing key must be entered.

“J Application D esigner - IWY_Cl_84 - IwW¥_CI_ATTRIBUTES (Component Interface)
Fle Edit Miew lnsert Buid Debug Took Go Window Help

INEEEE R EE =R

IWY_CI_ATTRIBUTES [Component Interface)

) wr_Cl64

-3 Component Irterface [E rw_CATTRIBUTES (Camps [[Name

: InY_CILATTRIBUTES 1 PSBCDEFN (T able) - Searc | hwy_CI_ATTRIBU.
&8 IwY_CI_MESS4GES =g Serol-Levelr

B3 Components B Somol - Lewsl 1 Pimary

8 Pages = 4@ FINDKEYS

PSBCDEFM  BCNAME

-] Recods Lo prasuE pSECERURCMANE

03 8a0 Component Interface Tester - Enter key values, choose function B3
=Gt keys for Component | rterface (double-click to set) ———————————

(= Ciatelkeys fon Componert | ntetace (o uble-dl of [ st

TeateliE |

[~ Findf keys for Comporent fick ta

o BCHEME I | gnd |

¥ Intersctive Mode: (s=t praperties immeciately)

I GetHistory llems cancel |

I~ Edit History Items

3K Development [F Upurate

Begin vaidating Component Interface inte grity =
Mo errors foun
End Companent Interface validation

T B Upgrate J\_ Resuls p Validate

Fieady FR40DMD

The exposed properties for the key that is entered are returned.
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>J Application Designer - IwY_CI_84 - IWY_CI_ATTRIBUTES (Component Interface]

File Edit ¥iew |nset Buld Debug Tools Go Window Help

IEEEE T =R

T IR pemmmm——
£ GelKeylrfoCallection
o BONAME LOCATION
£y FindKeylnfoCollection
i BONAME LOCATION
E1-E@ IwY_PSBCITEM W/
Twy_PSBCITEM v 1]
IW_PSBLITEM VW 2]
Iwy_PSBLITEM_Aw [3]
IW_PSBCITEM_ W [4]
IWY_PSBCITEM VW 5]
IW_PSBLITEM W 6]
IWY_PSBCITEM_ VW 7]
Iw_PSBLITEM_w 8]
IW_PSBCITEM_Vw 3]
Iw_PSBCITEM_Vw [10]
IW_PSBCITEM_Vw 1]
Iw_PSBCITEM_Vw [12]

WY PSRCITFM Vw131 =
4 ] 3

Error Message Log

1 Development [£E Uparade

Begin validating Companent Inteiface intearity
N

o ermors foun
End Component Interface valdation

T3 [ Buid_J: Upgrate J, Resis ), Yalisate /

Reay FeeoMo [

If this window is displayed, the Component Interface has been successfully tested for the Get
method.

6 Repeat this process for the IWY CI_ MESSAGES Component Interface.
You have finished testing the Component Interfaces.

Generating Component Interface APIs

You must create a PeopleSoft API to enable communications with the PeopleSoft application. The API
is a collection of Java class files that reside on the client machine and mediate between the client
application layer and PeopleSoft. You also must apply security to the component interface and test the
component interface (see “Securing a Component Interface” on page 64 and “Testing a Component
Interface” on page 69).

Building PeopleSoft Component Interface API Classes

Before you can build working integration applications with the Integration Manager Connect for
PeopleSoft®, you must create Java classes for the particular PeopleSoft services you wish to utilize, and
make these classes available to Integration Manager (at design time as well as runtime). These classes
serve as the API bindings that allow your Integration Manager components to perform Add, Update, and
other operations on the target PeopleSoft system.

To create the necessary Java classes, you will:

+ Determine which PeopleSoft services (methods) you wish to call from Integration Manager.
+ Create a Component Interface for each service using the PeopleSoft Application Designer.

+ Use the Application Designer to generate Java source files representing the API bindings for the
particular Component Interface(s) you want to use (which could be just a few, or potentially many).

+ Use javac.exe (in your JDK) to compile the generated Java sources into class files.
+ Use jar.exe (from the JDK) to assemble the class files into a Java archive (JAR).
+ Put the JAR on your design-time and runtime machines and make appropriate classpath updates.

The detailed procedure is as follows.
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> To create Component Interface Classes (and JAR)

1 Launch your copy of PeopleSoft Application Designer.

Go Fgvortes Window Help

RETE]

R
JOB_CODE_TBL (Compor————————————| Name Fecord Field Read Only | Comment
23 JOBCODE_TBL [Table_ Seffings. ER: ]
2 Serol-Level0 & BETKEYS
JOBCODE_TEL (T able) o SETID JOBCODE _TBL SETID
=) HR_LBL WRK Deiived) o JOBCODE JOBCODE_TBL J0BCODE
DERIVED [Derived) &> FINDKEYS
Scrol - Level 1 Primary Record: SET_JOB_BU_Viw/ Qo SETID JOBCODE_TBL SETID
&-F Sorol-Level 1 Primary Record: JUBCODE_TBL 3 JOBCODE JOBCODE_TBL J0BCODE
JOBCODE _TBL (Table] @ DESCR JOBCODE_TBL DESCR
FUNCLIE_HF: (Derived) @ GYT_OCC_SERIES JDBCODE_TBL GVWT_OCC_SERIES
DERIVED_IC_GBL Derived) & GYT_DFFICIAL_DESCR JOBCODE_TBL GYT_OFFICIAL_D
EG_IC_WRKD Derived) -5 CREATEREYS
DERIED_EG [erived) o SETID JOBCODE_TEL SETID
GUT_DERIVED_LBL [Derived) 3 JOBCODE JOBCODE_TBL J0BCODE
DERWED_GYT (Derived) =8 PROPERTIES
HR_LBL_WFRK [Derived) €9 JOBCODE_TEL JOBCODE_TBL
FPS_LBL_WRK [Derived) =3 METHIDS
S DERIVED_POPUP (Deiived) & Cancel
=) EXCH_RT_WAK [Derived) ¢ Cieale
DERIVED_HR_CHP [Deiived) ¢ Find
Geral - Level 2 Frimary Riecard: GYT_JCOD_FCT & Get
Scroll - Level 2 Primery Record: CAN_JOBCODE_CU & save
Serol-Level 2 Primary Record: JOBCD_TAN_PROG
Scrol - Level 2 Primany Record: JOBCD_SURVEY
Seroll - Level 2 Primary Fecord: JBCD_CMP_RT2 W
Scrall- Level 2 Primary Fecard: S4L_RATECD_TBL
Soroll- Level 2 Frimary Fiecord: JECD_CHP_RT3 i/
‘ | i3]

Begin validating Component Interface integiily
Mo eors found
End Component Intertace validation

0T Buid \_Find Otjec References i Upgrade  Resuls ) Validate

Het7osuN || I [

2 From the PeopleSoft Application Designer, open a component interface.

3  Click the right-hand pane to give it focus. Then select PeopleSoft APIs from the Build menu. (See
the previous illustration.)

The Build PeopleSoft API Bindings dialog box opens and prompts you for the types of bindings to

create.
“J Application Designer - Untitled - [JOBCODE (Component Interface]]
F]Fle Edt View Inset Buid Debug Took Go Favoiles Window Help =1 x|
olzBle] &l e @
JOB_CODE_TBL (Component) Narme; [ Record [ Field [ Read 0wy [ Comment |
£ JOBCODE_TBL (Table) - Search Record = g JOBCODE
= Seroll - Level 0 =& GETKEYS
B JOBCODE_TBL (Tatle) o SETID JOBCODE_TBL SETID
HR_LBL_WRK [Derived) ..o JOBCODE JOBCODE_TBAL J0BCODE
DERIVED (Derived) s 3 = e
-0 Serol-Level 1 Pimay Recont SET 108 AR e P T S > 1 .,
= B Sorol-Level1 Primary Record JOBCODE_ oy e 14 J0BCODE
. JFDui[EDLEEjE[LD[;:j]  Hiid Target Diecloy: [V-\psfiora\h 81 Fasurtbinclentuinids || . | E\Etifgcc_sswss
DERIVED_IC_GEL (Derived) Type Library Template: GWT_OFFICIAL_D.
EG_IC_WRKD (Derived)
-5 DERNED_EG (Derived) COM Server DLL Locafion: [V:\psftora\h8 7osuribin\clientwir G5 ETD
GVT_DERIVED_LBL (Derived] JOBOODE
DERIVED_GVT (Detived) AutcRegister 2 Clean-up Registy [V

HR_LBL_WRK (Derived)
FP5_LBL_WRK (Deiived)

CHeader
DERIVED_POPUF [Deived) [r Buid  Directory for header fle: [ WANNT Froffes'ehid28m Deskton | _ |

EXCH_RT_WRK [Derived)
DERIVED_HR_CHP Deived) JavaCl
Secroll-Level 2 Frimary Fiecord: BYT_I0 | [ g

Seroll- Level 2 Primary Recerd: CAN_IC

Sevoll-Lovel 2 Primery Figedt JTIBTD) || Difectory containing PeopleGoM package: [ \PSFTORAHETTOSUNwebhent | _ |
Serall-Level 2 Fiimary Fiecord: JOBCD,
Seroll-Level 2 Primary Fiocorct JBCD_C

Seroll - Level 2 Primary Record: SAL_ Ry ooiectAPls to Buid _Al| tone|
Scroll- Level 2 Primary Fecord: JCD_C B E [=]

-

Biegin valdating Component Interface integriy
Mo enors found
End Component Interface validation

AT Buld J\_Find Object Refererices_J\ Upgradie Jy Resuls ) Validate

Ready [werzosun [T

4 Ensure that Java Classes Build is selected (deselect “COM Type Library Build” if necessary), then
select a directory on your local machine where the generated Java files are to be placed.

5 Select the APIs for which you wish to generate Java source files. (Click the None button first, to
clear any selections.)

NOTE: In addition to the APIs for the selected component interface, you also must generate the
AP files for the following generic component interface properties:
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+  ComplntfcPropertylnfo
+  ComplntfcPropertylnfoCollection
6 Click OK. PeopleSoft generates the files. This may take from a few seconds to several minutes,

depending on how many selections you made. After the process is complete, a message appears in
the PeopleSoft Application Designer output window.

Compiling the Component Interface Files

The files you generated in the previous steps must be compiled into classes, and the classes packaged into
a JAR, before you can use them.

Note that PeopleSoft places the Java sources to be compiled in the directory called
[targetFolder] \PeopleSoft\Generated\CompIntfc

where targetFolder is the directory you specified during the build process.

There are two Java files for every API file that you selected when you generated the source files.

Before you compile the Java sources, you should confirm that you have a copy of the PeopleSoft Java
Object Adapter (the psjoa.jar file that resides on your PeopleSoft Application Server under the
PS_HOME\Web\psjoa directory). Note its location.

> How to Compile the generated PeopleSoft APl Java sources

NOTE: Before beginning, ensure that you have a copy of Sun’s JDK (1.4.x or later) on your machine.

1 If you are compiling on a machine that does not have a local copy of the psjoa.jar file, bring a
copy onto the local machine. You will need to have this JAR in the classpath in order for
compilation to occur without errors.

2 Compile the files. To do this, first open an operating-system console and navigate to the target
folder you specified in the Java Target Build step (step 4) of the previous procedure. From there,
run a batch file or shell script that invokes the javac.exe program in your JDK to compile the
sources. A typical Windows batch file that does this might look like:

@echo off

set JAVA HOME=<my-java-home>

set PATH=%$JAVA HOME%\bin; $PATHS

set CLASSPATH=%JAVA HOMES$\lib\tools.jar;psjoa.jar; $CLASSPATHS%

javac -classpath $CLASSPATHS% .\PeopleSoft\Generated\CompIntfc\*.java

where:
<my-java-home>
is the fully qualified path name of your Java home directory.
3 Compress the class files into a JAR file. Again, start from the target directory you specified in the

Java Target Build step of the previous section’s procedure. A Windows batch file similar to the
following will create a JAR file named psGenComp.jar:

@echo off

set JAVA HOME= my-java-home

set PATH=%JAVA HOME%\bin;3PATHS

set CLASSPATH=%JAVA HOMES$\lib\tools.jar;$CLASSPATHS

jar cvf psGenComp.jar .\PeopleSoft\Generated\CompIntfc\*.class

Substitute the appropriate path for my-java-home. (e.g., c:/jdk142.)

NOTE: Java is case-sensitive. Be sure to use the correct case when creating the JAR file since the
Java classloader mechanism depends on this.

4 Place the resulting JAR file (in this example, psGenComp.jar) into your Integration Manager
installation’s Common/lib directory. This applies to both design-time and runtime machines, if
they are different.
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Updating and/or Activating Your License(s)

You will need to activate your design-time and runtime copies of the Novell Integration Manager
Connect for PeopleSoft® before using them. Follow the procedure outlined below.

Updating the Design-time License

1

Obtain a valid license string from your Novell representative.

NOTE: The same license string will be used to activate both the design-time and runtime versions
of the software.

Launch Integration Manager.

Use the About Integration Manager command on the Help menu, on Integration Manager’s main
menu. An “About” screen appears.

At the bottom of the “About” dialog, click the System button. A System Information dialog
appears.

Near the top of the System Information dialog, click the Licenses tab to bring it forward.

x|
Status | Licenses || Credits
Installed Component License Information
Mame License Enabled Status |
JD. Edwards F13952C06320050521 | = Mot Loaded
D, Edwards Service F13952C06320050521 | = Mot Loaded
IS | Edi... Loaled
JMS Service | Edi... Loaled
Lawson F13952C671 20050521 | = Mot Loaded
Lawson Service F13952C671 20050521 | = Mot Loaded
Frocess [ Edlit... ] Loaded
PecpleSoft F13952C70020050521 | = Mot Loaded
PeopleSoft Service F13952C70020050521 | = Mot Loaded
Siebel F13952C91 220050521 | = Mot Loaded
Siebel Service F13952C91 220050521 | = Mot Loaded
Service Provider [ Edlit... Loaded
Service Provider Type [ Eclit... Loaded
Terminal StyleSheet [ Edlit... Loaded
T27 Terminal | Edi... Loaled
T27 Logon | Edit... Loace
Tandem Terminal [ Edlit... Loaded
Tancem Logon | Eclit... Loaded

Scroll down until you see the table row for PeopleSoft.
NOTE: The Connect ships with an Evaluation license string which may be used for 90 days.

To use the evaluation license string, select the check box in the Enabled column and skip to Step
10. To enter a different license string, select the check box in the Enabled column. The Edit button
in the Siebel row is enabled.

Select Edit in the PeopleSoft row. The Edit License dialog box is displayed.
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11
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13

Edit License x|

Product Mame PeopleSoft

Mew License l

” Cancel

Type the license string for the Integration Manager Connect for PeopleSoft in the New License
field.

Scroll down until you see the row for PeopleSoft Service.

Repeat Step 7 through Step 9 for the PeopleSoft Service row.
Click OK.
Exit out of all dialogs using the OK button.

Updating the Runtime License

NOTE: If you are using the Tomcat application server, copy the jca10apis.jar from the \NIM6\Server
Resources\Tomcat directory (Windows) or nim/Server Resources/Tomcat directory (Linux) to the
Tomcat Composer\lib and shared\lib directories before attempting to update the runtime license.

1

2

4

Start the application server if it is not already running. (Novell Integration Manager Enterprise
Server should already be installed. It will start when the application server starts.)

Open a browser window and navigate to the Novell Integration Manager main administrative
console. Typically, this is at:

http://localhost/exteNdComposer

In the upper left corner of the console window, click the exteNd Composer logo immediately
above the words “Server Console.” See the following illustration.

exteMNd Compo e Yersionflicenze Manager

Y o PEEEREE

General properties | Novell’exteNd" Composer

|Versiun 5

About Products:

In the content area of the main frame, near the bottom, click the Licenses button. A new window
will open, showing the license status of every Integration Manager Connect. See the following
illustration.
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*-‘i}Manage Licenses - Mozilla Firefox

exteNd Composer

psft |E139520?D020050521 Mot Loaded
psftserce |E139520?D020050521 Mot Loaded
shl |E13952091220050521 Mot Loaded
shlserdce |E13952091220050521 Mot Loaded
serviceprovider I Loaded
@ Done

5 Scroll down to the entry labeled “psft”.

NOTE: The Connect ships with Evaluation license strings which may be used for 90 days.

6 Type alicense string in the text field in the “psft” row; then select Enabled in the “psft” row. To use

the evaluation license string, just select Enabled.

7 Select Update in the “psft” row.

9 Type a license string in the text field in the “psftservice” row; then select Enabled in the
“psftservice” row. To use the evaluation license string, just select Enabled.

Scroll down to the entry labeled “psftservice”.

10 Select Update in the “psftservice” row.
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Creating a PeopleSoft Component

To create a Component that utilizes the Integration Manager Connect for PeopleSoft, you will generally
need to do three things:

+ Create a Connection Resource (to allow your component to connect to a PeopleSoft system)
+  Create any necessary XML Templates
¢ Create the Component itself (containing your business logic)

Each of these processes is discussed in detail in this chapter.

Creating Connection Resources

Before creating a component that interacts with a PeopleSoft system, you need to create a Connection
Resource, which is a lightweight Integration Manager object (xObject) that encapsulates basic
connection information (parameter values) associated with a connection to a back-end system.

In addition to a connection resource, a PeopleSoft Component requires that you have already created
XML templates so that you have sample input and output documents for use in designing your
component. For more information, see “Creating an XML Template” in the Novell Integration Manager
User s Guide.

If your component design calls for any other resources, such as custom scripts, XSL, XSD, etc., it is best
to create these before creating the PeopleSoft Component. For more information, see “Creating Custom
Scripts” in the Novell Integration Manager User s Guide.

Types of Connection Resources

You create different types of connection resource depending on the type of interaction with the
PeopleSoft system that is desired. If your application needs to initiate PeopleSoft business events, you
need to create a PeopleSoft Connection resource. If your application needs to process data when a
business event occurs within PeopleSoft, you need to create an inbound connection resource. Inbound
connection resources include file, HTTP, and TCP connection types.

About Constant-Driven and Expression-Driven Connection Parameters

You can specify Connection parameter values in one of two ways: as Constants or as Expressions. A
constant-driven parameter uses the value you type in the Connection dialog every time the Connection is
used. An expression-driven parameter allows you to set the value using a programmatic expression,
which can result in a different value each time the connection is used at runtime. This allows the
Connection’s behavior to be flexible and vary based on runtime conditions each time it is used.
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For instance, one very simple use of an expression-driven parameter in a Connection would be to define
the User ID and Password as PROJECT Variables (e.g.
PROJECT.XPATH(“USERCONFIG/MyDeployUser”). This way when you deploy the project, you can
update the PROJECT Variables in the Deployment Wizard to values appropriate for the final deployment
environment. At the other extreme, you could have a custom script that queries a Java business object in
the Application Server to determine what User ID and Password to use.

> To switch a parameter from Constant-driven to Expression driven:
1  Click the right mouse button in the parameter field you are interested in changing.

2 Sclect Expression from the context menu and the editor button will appear or become enabled.

B[
%@ ECMA Expression
vse.. | I LDAP Expression

3 Click on the button and then create an expression that evaluates to a valid parameter value at
runtime. (Strings should be wrapped in double-quotes.)

Creating a PeopleSoft Connection Resource

32

> Tocreate a PeopleSoft connection resource:

1 Select File > New > xObject and select the Resource tab. Click on Connection. The “Create a
New Connection Resource” Wizard appears.

Create a New Connection Resource x|

A Connection resource is uged to establish communications with an Connectar data source orwith a server
using HTTP authentication. You need to create connections for each type of data source or each HTTP server
you wish to communicate with. Enter a name and, optionally, a description for this Connection. The name
will appear in the Composer Detail Pane and in choice lists when you are prompted for ohjects in Composer.
The name may not cantain the characters: 0 ?" = = || Mames are case insensitive.

MName:

hytewCannection|

Description:

FPurpose:
Input
Cutput
Remarks:

(next ][ cancel

2 Type a Name for the connection object.
3 Optionally, type Description text.
4 Click Next. The parameters panel appears.
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12

13

Create a New Connection Resource x|

Specify PeopleSoft specific parameters here to make connection to PeopleSoft EIS

Connection Type IPeopIeSoﬂ Connection Test

Application Server I O Defaut

PeopleSoft Port IQDDD

User ID I

Password I

Intial Paal Size [1

IMaximum Pool Size |1 0

[ < Back ][ Finish ][ Cancel ]

Select PeopleSoft Connection from the Connection Type pull down menu.

In the Application Server field, enter the host name or IP address for the PeopleSoft server that
you’ll be using.

NOTE: This parameter, and all subsequent parameters in this dialog, can be dynamically set using
Expressions. See the discussion “About Constant-Driven and Expression-Driven Connection
Parameters” later in this chapter.

In the PeopleSoft Port ficld, enter the appropriate port number.
Enter a valid User ID to sign on to the selected PeopleSoft server.
Enter a valid Password.

In the Initial Pool Size field, enter the desired J2EE™ Connector Architecture pool size. (Not
applicable for non-managed environments.)

Enter a Maximum Pool Size as desired. Again, this is a J2EE™ Connector Architecture setting.
(Not applicable for non-managed environments.)

If desired, select Test to see if your connection parameters and current network environment will
allow you to create a live connection. (The connection is discarded immediately after the test.) A
“success” or “failure” message dialog will appear. You can continue working with the resource,
even if your connection fails.

NOTE: This does not test the connection pool (if defined).

Click Finish. The newly-created resource connection object appears in the Integration Manager
Connection Resource detail pane.
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¥ exteNd Composer: ActionExamples =|0O] x|
File Edit View Tecls Windew Help

OEl%d0X Novell
El G Resource ]
; B codeTahle
g C Map

E Image
Java Gerver Page
I Er A (v]
(<] RE)
[ Iame ]J
I ertorySystem
Wy MeswCannection MNew Connection

Resource

| ﬁ Project Gl_', Registriss

]‘@” ngJ[Q‘\_ Find|| F¥ watcn|[ « Todo
Ready

Creating a File Service Connection Resource

> To Create a PeopleSoft File Service Connection Resource:

1 Select File > New > xObject. The New xObject dialog box is displayed.

2 Sclect the Resource tab.
3 Double-click on Connection. The “Create a New Connection Resource” wizard is displayed.
4 Type a name for the connection object in the Name field.
5 Optionally, type a description of the connection object in the Description field.
6 Seclect Next. A connection parameters panel is displayed.
x|
Specify PeopleSoft Service File specific parmmeters here to make conneclion o PeopleSoft EIS.
Connection Type IPenp\eSnﬂ Service File Connection Test
Polling Location I l Browse ] [ Defautt
File Masl: [*
Synchronization Type IHEOUEST
Responsel/Ack Directory I l Browse ]
Error Directory I l Browse ]
Foll Interval IBDDD
Processing Mode IBEquEntlaI
Thread Limit '3
[ < Back ]I Finish I[ Cancel ]

7 Select PeopleSoft File Service Connection from the Connection Type list.

8 Use the Browse button next to the Polling Location field to select the target file system location
for the PeopleSoft XML file.
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10

11

12

13

14

15

16

17

In the File Mask field type the file name to be used for the output file generated as a result of this
operation. The default is “.*”.

Select REQUEST, REQUEST RESPONSE, or REQUEST ACK from the Synchronization Type
list. Select the option that is correct for the Workflow with which you are integrating (e.g., if your
Workflow is set up to process a response, select REQUEST RESPONSE). The Synchronization
Type selected also determines the tabs that are displayed in the Service Request Native
Environment pane (e.g., if REQUEST RESPONSE is selected, both Request and Response tabs
are displayed).

Use the Browse button next to the Response/Ack Directory field to select the directory to which
responses or acknowledgements from your application will be written.

Use the Browse button next to the Error Directory field to select the directory to which error
information will be written.

In the Poll Interval field, type the interval (in milliseconds) in which the Polling Location is
checked for input. The default is 3000 (3 seconds).

Select Threaded or Sequential from the Processing Mode list. Threaded indicates processing of
multiple requests simultaneously. Sequential indicates serial processing of requests.

If Threaded processing mode is selected in the Processing Mode list, use the Thread Limit field to
specify the maximum number of requests that can be processed simultaneously.

From the Metadata Connection list, select a PeopleSoft connection resource from the list of
defined connection resources. This connection is used for acquiring metadata from the PeopleSoft
system.

Type the desired maximum pool size in the Maximum Pool Size field. This is a JCA setting that
specifies the maximum number of connections to be allowed in the connection pool (not applicable
for non-managed environments).

Creating an HTTP Service Connection Resource

> To Create a PeopleSoft HTTP Service Connection Resource:

1

o a b WON

Select File > New > xObject. The New xObject dialog box is displayed.

Select the Resource tab.

Double-click on Connection. The “Create a New Connection Resource” wizard is displayed.
Type a name for the connection object in the Name field.

Optionally, type a description of the connection object in the Description field.

Select Next. A connection parameters panel is displayed.

Create a New Connection Resource x|

Specify PeopleSoft Senvice Hitp =pecific parameters here 1o make connection o PeopleSoftEIS.

Connection Type IPenp\eSnﬂ Service Hitp Connection Test
Listener Port FDSD [ Defautt
Hitp=s ]
Synchronization Type IFHECJUEST
Metaclata Connection IpBﬂ'I 81EF
Maximum Pool Size |1 1]
< Back ]I Finish l[ Cancel
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12

Select PeopleSoft HTTP Service Connection from the Connection Type list.

In the Listener Port field, type the number of the port on which the application will listen for
PeopleSoft event data. The default port is 8080.

To use HTTPS for this connection, select HTTPS.

Select REQUEST, REQUEST RESPONSE, or REQUEST ACK from the Synchronization Type
list. Select the option that is correct for the Workflow with which you are integrating (e.g., if your
Workflow is set up to process a response, select REQUEST RESPONSE). The Synchronization
Type selected also determines the tabs that are displayed in the Service Request Native
Environment pane (e.g., if REQUEST RESPONSE is selected, both Request and Response tabs
are displayed).

From the Metadata Connection list, select an outbound PeopleSoft connection resource from the
list of defined connection resources. This connection is used for acquiring metadata from the
PeopleSoft system.

Type the desired maximum pool size in the Maximum Pool Size field. This is a JCA setting that
specifies the maximum number of connections to be allowed in the connection pool (not applicable
for non-managed environments).

Creating a TCP Service Connection Resource

> To Create a PeopleSoft TCP Service Connection Resource:

1

o a b WON

7
8

9

Select File > New > xObject. The New xObject dialog box is displayed.

Select the Resource tab.

Double-click on Connection. The “Create a New Connection Resource” wizard is displayed.
Type a name for the connection object in the Name field.

Optionally, type a description of the connection object in the Description field.

Select Next. A connection parameters panel is displayed.

Create a New Connection Resource x|

Specify PeopleSoft Service TCP specific parameters here 1o make connection to PeopleSoft EIS.

Connection Type IPeop\eSoﬂ Service TCP Connection Test

Host |\Dcalhost [ Defautt

Part I
Synchronization Type IF!ECEI\.-’E_FHEF'L‘fr
Iz Length Prefix ]

IsxL O
Is Keep Alive [
Metadata Connection Ipsﬂ‘l 81EP

Maximum Pool Size |1 1]

[ < Back “ Finish ” Cancel ]

Select PeopleSoft Service TCP Connection from the Connection Type list.

In the Host field, specify the host name or URL of the system on which the PeopleSoft system is
installed.

In the Port field, type the name of the port on which the host is listening.

10 Select RECEIVE REPLY, RECEIVE ACK, or RECEIVE from the Synchronization Type list:.

+ Select RECEIVE REPLY if the PeopleSoft application expects a reply sent back to it.

+ Select RECEIVE ACK when a TCP/IP acknowledgement (ACK) is sent back to the PeopleSoft
application.

36 Novell Integration Manager 6 Connect for PeopleSoft User's Guide



+ Select RECEIVE if the PeopleSoft application does not expect a return.

11 Seclect Is Length Prefix if the PeopleSoft application sends data that is not in XML format. The
TCP/IP event application must prefix the data with a 4-byte binary length field when writing the
data to the TCP/IP port. When this option is selected, deselect the Is XML option.

12 Select Is XML if the PeopleSoft application sends data in XML format. When this option is
selected, deselect the Is Length Prefix checkbox.

13 Seclect Is Keep Alive to maintain continuous communication between the PeopleSoft application
and your application.

14 From the Metadata Connection list, select an PeopleSoft Connection resource from the list of
defined connection resources. This connection is used for acquiring metadata from the PeopleSoft
system.

15 Type the desired maximum pool size in the Maximum Pool Size field. This is a JCA setting that
specifies the maximum number of connections to be allowed in the connection pool (not applicable
for non-managed environments).

XML Templates for PeopleSoft Components

Before creating a PeopleSoft Component, you should create any XML templates that might be needed.
This basically means telling Integration Manager what XML samples to use. (For more information, see
Creating a New XML Template in the separate Novell Integration Manager User’s Guide.) Once you’ve
specified the XML templates, you can create a component, using the template’s sample documents to
represent the inputs and outputs processed by your component.

Creating PeopleSoft Components

Also, as part of the process of creating a PeopleSoft Component, you can select a preexisting PeopleSoft
connection resource, or you can create a new one. If you create the connection beforehand (as outlined in
the previous chapter), then it is available to for use by any PeopleSoft Components in the current project.
If you have not already created at least one PeopleSoft connection resource in the current project, you
will be prompted to do so when you try to create a PeopleSoft Component.

NOTE: You can still create a Component without first creating a Connection Resource, but you won’t be
able to use any debug features that depend on a live connection.

> To create a new PeopleSoft Component:

1 Seclect File>New>xObject. In the dialog that appears, select the Component tab and then the
PeopleSoft component type.

NOTE: Alternatively, under Component in the Integration Manager Navigator pane (explorer
view), you can highlight PeopleSoft, click the right mouse button, then select New.

2 The “Create a New PeopleSoft Component” Wizard appears.
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Create a New JDBC Component x|
AJDBC componentis used to push XML data into relational databases or pull data from thermn into XML
documents. This wizard will guide you through the creation of a JDBC Component. Please enter a name
and, optionally, a description for the JOEC component. The name will appear in the Composer Detail Pane
and in chaice lists when you are prompted for abjects in Compaser. The name may not contain the
characters:t f: 7 "= = | Mames are case insensitive {l.e. MyObjecthame is the same as myabjecthame).
ame:

MyJDBCComponent
Description:
Furpose:
Input:
Cutput:
Remarks:
| | (et ) Cancet

3 Enter a Name for the new PeopleSoft Component.

H

Optionally, type Description text.

5 Click Next. The XML Input/Output Property Info panel of the New PeopleSoft Component Wizard
appears.

Create a New JDBEC Component |

Specify one or more XML Templates to help design Input to this Component ar'Wehb Service and only ane to
design Output. The sample XML Documents in each Template are design time aids to help you build Action
Madels forthe component. The samples are not actually used at runtime after deployment to your application
server. The ldentifier is fixed and reprasents the name used ta refer ta the XML Document during companent
execution. Selecting System {ANY} allows you to use an emply template {i.e. accept any document as Input).

Input Message
Part | Template Category | Template Name

|
Input | 5ystem) [ 4y v

Output Message
Part | Template Category | Template Name

|
Output | 5ystem) [ [1anvy [v]

[ Back ][ Mext ][ Cancel]

6 Specify the Input and Output templates as follows.

+ Type in a name for the template under Part if you wish the name to appear in the DOM as
something other than “Input”.

+ Select a Template Category if it is different than the default category.
+ Select a Template Name from the list of XML templates in the selected Template Category.

+ To add additional input XML templates, click Add and choose a Template Category and
Template Name for each.

+ Toremove an input XML template, select an entry and click Delete.
7 Select an XML template for use as an Output DOM using the same steps outlined above.

NOTE: You can specify an input or output XML template that contains no structure by selecting
{System}{ANY?} as the Input or Output template. For more information, see Creating an Output
Document without Using a Template in the Novell Integration Manager User’s Guide.

8 Click Next. The Temp and Fault XML Template panel appears.
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11

12

Create a New JDBC Component

x|
Specify one or more Temp and Fault XML Templates to help design temporary parts and fault handling for
this Compaonent orWeb Service. Use Termp documents for creating intermediate results ar holding values

for reference. Specify XML Templates to serve as Fault documents to be passed back to clients under error
conditions.

Temp Message
Part

Template Category Template Mame |

Fault Message
Part \

Template Category | Template Name

| SystemFautt | isystem} [ ||ty
[ Back ][ Next ][ Cancell

If desired, specify a template to be used as a scratchpad under the “Temp Message” pane of the
dialog window. This can be useful if you need a place to hold scratchpad values that will be used
temporarily during the execution of your component. Select a Template Category if it is different
than the default category. Then select a Template Name from the list of XML templates in the
selected Template Category.

Under the “Fault Message” pane, select an XML template to be used to pass back to clients when
an error condition occurs.

As above, to add additional input XML templates, click Add and choose a Template Category and
Template Name for each. Repeat as many times as desired. To remove an input XML template,
select an entry and click Delete.

Click Next. The Connection Info panel of the “Create a New PeopleSoft Component” Wizard
appears.

Create a New JDBC Component

Specify which Connection you wish to use for this Compaonent or Service. To change any cannection
parameters, you must change them in the Cannection Resource object or create a new Caonnection
Resource ofthe same type with different parameters.

x|

Connection |\nver‘rtnry8ys‘tem

JDBC Driver |

JDBC URL |

User ID I

Password I

DB Params I

Deployed Pool Mame I

Allow 50 Transactions

[ Back H Finish H Cancel

13 Select a PeopleSoft Connection from the Connection list.

14 Click Finish. The component is created and the PeopleSoft Component Editor appears.

About the PeopleSoft Component Editor Window

The PeopleSoft Component Editor includes all the functionality of the XML Map Component Editor. It
contains mapping panes for Input and Output XML documents as well as an Action Model.
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The PeopleSoft Component Editor also includes a Native Environment Pane, which appears as a grey
pane until you create a PeopleSoft Request action, at which time it will show a tabbed Request/Response
pane with corresponding XML trees.

W exteNd Composer: TutorialEnd [JDBC: Inventorylookup] 13 =l
File Edit View Component Action Animate Tools Window Help HO - & x
D@8 00X 4 < Novell
|%® InventoryLockup "3@ uyJDBCCcmponentl
@ Input Data Bx
=== FRODUCTREGL
< wming hitt: (i, COMIPOSEE.CO
Input Native Environment
mapping pane pane
@ Output Data Bx CW[@@Q (]
=-<> IMNVENTORYSTAT|
<> skuU

J§7 LOG ™rn"™ + "Component starting..." + "ir'n" TO System

:; SQLTN%RY QL Execute SQL: SELECT *FROM Invento rySystern WHERE
<>CosT E=Y TO $OUtputINVEN
> T ﬁ . GORY Via Code T:
Output E= Action Model pane k1o soutputme
mappmg pane W rin" TO Systern O

<] 2]

Peady

(The Native Environment Pane shown here is blank, because no PeopleSoft Request action has yet been
created.)

Creating Actions in the Component Editor

You can create all the normal Integration Manager actions in the Action Model of your PeopleSoft
component (e.g., XML Map, Function, Log, Send Mail, and so on). In addition, you can create a
PeopleSoft Request action.

The PeopleSoft Request action communicates requests (XML request documents) to your PeopleSoft
system and fetches responses back from the same system.

The Integration Manager GUI for creating a PeopleSoft Request action allows you to

« specify the type of PeopleSoft function (or “service”) you want to invoke

+ automatically generate XML schemas (request and response) for the particular Component
Interface API you wish to use

+ use the generated schemas to fine-tune the exact structure of the actual request document you want
to use (a request document that conforms to the schema but reflects your own “setup” choices and
initialization parameters, etc.)

+ automatically generate the corresponding XML request and response documents that conform to
the schemas and choices you’ve made

You will see how this works in the procedure given below.
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> Tocreate a PeopleSoft Request action

1 Right-click in the Action Model at the location where you wish to create a new PeopleSoft Request
action, then (in the context menu that appears) choose New Action > Request.

Mew Action r Request, .
Edit Action... Advances >
Dizable Action Data Exchange b
Toggle Breakpoirt Process ¥
Clear all Ereakpoints Repeat 3
Cut Commernt... Ctri+E
Copy Componert...  Cr+T
Decision... Ctri+D
Delete... Declare Alias ...
Fir... Function... Ctri+L
Finel Mext Log... Ctri+L
Replace. .. fap... Ctrl+ia
Send Mail...
Switch...
Todo...

2 Inthe dialog that appears (see below), give focus to the Functions tab and expand the topmost node
(Component Interfaces) in the tree-view shown.

x

Pick & function by navigating the function tree, or use Find' fram the
alternate mouse button on searchable tree nodes. Choose a function
node by douhble clicking the rmouse or by selecting 'Get Schemas' from
the alternate mouse hutton. Then select fields for mapping an the
Reguestand Response tabs.

Selected Function: NOMNE
Functions:

o= Component Interfaces
[+ f% CORPORATE_CARD

£ COUNTRY

£ CURRENCY

Fo DELETE_ROLE

F+ DELETE_USER_PROFILE

o DEPT

Fo DIRMML_SCHEMAD

Fe DIRXML_SCHEMADZ

Fo DIRXML_TRANSO1

Fe DIRXML_TRANS0Z2

Fe DIRXML_TRANS03

£ DIRXML_TRANSO04

F EMPLOYEE_CORPORATE_CARD

F EO_BUILDRULE

F EO_EIP_WF_MSG_BC

[ OK ][ Cancel ]

You will see a list of functions corresponding to those for which Component Interface classes were
built (see “Deploying the PeopleSoft Component Interface Files” on page 15 and “How to Create a
New Component Interface” on page 61).

|+ H+H+EHFEHE A H A HEHEH ]

+ All nodes have tooltips specifying the node type:
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+ Folder and Searchable Folder nodes: “type — Folder”

LEINT3

+ Function nodes: “type — EventOp”, “type — Operation”, “type - Message”

3 Right-click on the function of interest. Select Get Schemas from the context menu that appears. (If
the command is not available, it means no Component Interface API classes are available for this

Function type.)

Functions:

[ f PT_AMM_DUMNTY
e ROLE_MAINT

Fe SALARY _GRADE
£ SALARY_PLAN
Fe SIMPLEGRAPH

Fe STATE

F TRAININGLETTERS
e UOM

[+
[+
[+
[+
[+
[+
[+

=

[Ty

Get Schemas...

[F- create Keys
-3 Properties

4 After a few seconds, the Request and Response tabs of the dialog should become enabled. When

this has occurred, select the Request tab to bring it forward.

Pick a function by navigating the function tree, or use ‘Find' from the
alternate mouse button on searchable tree nodes. Choose a function
node by double clicking the mouse or by selecting 'Get Schemas'from
the alternate mouse button. Then selectfields far mapping on the
Reguest and Response tabs.

Function | Request ] Response |

Reguest Message:

x|

|Request1
Request Tree
[+
[ O key
CJUserlD
[ UserDescription
[ Emailaddress
I PrimaryPermissionList
O RowsSecurityPermissionList
] symholiclD
[ LanguageCode
] mMultiLanguageEnabled
O CurrencyCode
[ AccountLocked
[ ProcessProfilePermissionList
[0k Cancel |

5 Enter a request-message (document) mapping name, or accept the default as shown.

6 Select the elements that you want to occur in the Request document, by checking or unchecking
checkboxes in the node tree. Some nodes are greyed out (disabled) while others are not. This is
because the document’s schema determines which nodes you can edit.

Integration Manager will not let you specify an invalid request document, because the things you
should not edit are greyed out (disabled), and the editable items for which customization is allowed
have RMB context-menus that non-customizable nodes do not have, etc. For example:

o Mandatory elements and attributes are marked selected and disabled.

+  All child nodes are left unselected and disabled if the parent node is not selected.

42
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+ A parent element, once selected, will autoselect mandatory elements and attributes underneath
it.

+  When a parent node is selected, you will need to select optional element manually.

Tool tips are an important aid in using the Request and Response panes, because they display
document-structure rules that come straight from the corresponding Component Interface
request/response document schema. You should take time to familiarize yourself with the tooltip
feature by letting the mouse hover over various nodes. An example is shown below.

] It

Parameter 'key' has these propetties:
FrinitrUEn occurrence: 0

FrEiFLIm occurrence: unbaunded
mikirauen data lenogth: 0

maximurm data lenoth: unbounded
datatype string

intial walue iz sample

o T o o o o T

OO s

NOTE: The tooltips that appear in this tree are also made available in the Native Environment
pane.

If a node has “maximum occurrence” of more than one, then a RMB menu command called “Create
new...” is available. Choosing that command brings up the following dialog:

x

Enter number of new nodes

o

[ Help @ [ 0K ” Cancel l

Enter the number of additional instances of this node-type that you want to insert in the document.
Then click OK. New nodes are added to the document structure.

CAUTION: There is currently no Undo for this.

If an Enumeration Button appears to the right of a given node, you can click it to choose from the
list of appropriate (schema-allowed) values for that enumeration.

= IDTypes

Select Parameters

1 IDType

A common situation is that an enumeration offers choices of Update, Insert, or Delete. An example
of this is shown in the following illustration, which shows the dialog that appears when you click
an Enumeration Button.
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Select Parameters |

[#]
® update
O delete
O insert

[T6K ][ cancel |

9 Visit all of the nodes in the request tree that are of interest to you, and use the various Integration
Manager UI features to customize the request document’s structure.

10 When you are satisfied with the structure, click the Response tab at the top of the dialog to bring the
Response document pane forward. This pane shows a tree view of the response document, similar
to the one shown for the Request document.

x

Pick a function by navigating the function tree, or use Find' from the
alternate mouse button on searchahle tree nodes. Choose a function
node by douhle clicking the mouse or by selecting 'Get Schemas' from
the alternate mouse button. Then select fields for mapping on the
Reguest and Response tahs.

Function || Request | Response

Response Message:

|Respunse1

Filter Response

Response Tree

]

3] result
error
I done

[ OK ][ Cancel l

11 Check or uncheck Filter Response as desired. It is checked by default. If this box is unchecked, the
tree will be disabled and greyed (no longer editable), meaning that a default schema configuration
will be used. When the box is checked, you can customize the structure of the request document by

specifying various types of node filtering.
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12 Visit all of the nodes in the Response document tree and customize the settings as desired. (See
previous steps, applicable to the Request document, for an explanation of the Ul semantics.)

13 Click OK. (Otherwise, use Cancel.) The dialog goes away and a new action appears in the Action
Model of your component. At the same time, the Native Environment Pane changes to show the
Request and Response tabs along with corresponding tree views of the fully customized
document(s).

14 In the normal component editor view, drag and drop data from the Input document pane to the
Request document of the Native Environment Pane, as desired. This will create mappings from
your Input document to the Request doc that will be submitted to the PeopleSoft server. The
mappings will appear (automatically) as new XML Map Actions in the Action Model.

15 Repeat the drag-and-drop mapping process for the Response document, dragging nodes from the
Native Environment Pane to the component’s Output document tree view. Again, this will
automatically cause new Map Actions to appear in your Action Model. (You can cut/copy/delete
the actions once they appear in the Action Model pane.)

16 Add or remove actions from the Action Model as needed to create the business logic you need.

Returning to Schema-Edit Mode

Once you have created a PeopleSoft Request Action in your action model (using the above procedure),
you can go back and revisit the Request and Response schema trees (and change your customizations)
simply by doubleclicking the Request Action in your action model. Doubleclicking will cause the
PeopleSoft Request Action dialog to reappear. You can use the Request and Response tabs to navigate the
request- and response-doc schemas and change your customizations as desired. When you exit out of the
dialog, your changes will be reflected in the Native Environment Pane.

NOTE: If you make hand-edits to the Request or Response documents in your Native Environment
Pane, you will not be able to reopen the PeopleSoft Request Action dialog. (See discussion further below.)
Therefore, try to avoid manually editing request/response documents. Instead, make modifications
through careful use of the XML Map Action or by using Request.createXPath( ) and/or DOM methods in a
Function Action.

Request and Response Documents

After you have created the PeopleSoft Request Action using the foregoing procedure, the Native
Environment Pane portion of the Integration Manager editor view will show Request and Response
documents in tree-view form.

|J Request ]| Fesponse |
i Request] [pata

<> camponent JSER_PROFILE
[ZH<> ey
<7 name UserlD

<> zerD
<> |zerDescription
<> plternatelUserlD

As mentioned earlier, you can drag and drop data from your component’s Input document to the Request
document to create XML Map actions. (First, put focus on the target Request-document node by clicking
in it. Then go to the Input document and click-drag any data you want to map over to the target node in

the Request document.) You can use drag-and-drop mapping to map from Response to Output, as well.

In the illustration shown above, some nodes are shown in red. The red entries represent nodes to which

data have been mapped.
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Manually Editing the Request and Response Docs

If you right-click anywhere inside the Request or Response tree views in the Native Environment Pane,
you will get a context menu.

|‘ Request || Response

& Request]

[F=>psa
........... Map...

— > ey Edlit Data...
n: Expand Tree
>z Collapse Tree
>Usi  Reload Tree

> Alte Eclt Doucmert... .

The Edit Document command in this menu will open the document in a text-editor view as shown
below.

Edil: Document x|

<¥xml verzion="1.0" encoding="UTF-5" #=
<PSg-
<component perform="inzeit">»USER_PROFILE</component:=
~key name="lzer|D"i=
=UserlDi=
<UserbDescription/>
<~aAlternatelUserid/>
<PS8=

0K ][ Cancel

In this window, you can hand-edit the Request or Response document as desired.

CAUTION: /fyou make hand-edits to the document, it may no longer conform to the original schema. As
a result, you will no longer be able to reopen it in the PeopleSoft Request Action dialog.

Note that if you’ve made hand-edits to a Request or Response document, doubleclicking on the
corresponding PeopleSoft Request Action in the action model will cause the following dialog to appear:

x

This Action can no langer be edited because the Request! mapping message has
heen manually modified.

Ifthis dialog appears, you will need to recreate the action in order to see the original Request or Response
document. (Any hand edits will be lost, however.)

46 Novell Integration Manager 6 Connect for PeopleSoft User's Guide



To prevent this situation from occurring, avoid making manual edits to Request or Response documents.
Instead use XML Map Actions (and/or Function actions) to modify documents or node contents. Be
aware that doing so may violate schema constraints. This will not necessarily cause runtime problems for
your component when executing in the Integration Manager Enterprise Server environment, because
Integration Manager does not validate the request document against the schema at runtime, on the server.
However, your PeopleSoft system may validate incoming requests, in which case a hand-edited Request
document could be the source of hard-to-troubleshoot errors.

“Before Execute” and “After Execute” Actions

You will notice that whenever a PeopleSoft Request action is created in your Action Model, two
additional lines are added to the action list: Before Execute Actions and After Execute Actions. These are
header labels (grouping labels) for blocks of actions that you want to occur before the request is sent to
the PeopleSoft system or affer a response document has come back, respectively. Typically you will want
to map data fields from Input to Request and have those actions be grouped under the “Before Execute
Actions” header. Likewise, any map actions or other action logic you need to perform on the Response
document after the PeopleSoft system executes you request should be grouped under the “After Execute
Actions” heading.

= ‘iﬂ FeopleSoft Reguest: USER_PROFILE

[BEEefore Execute Actions
‘5 MAP $PS_TEMPLATEPSSresult EffectiveDateFrom TO $Requestins1:PS8/E

ﬁ MAP $PS_TEMPLATEPS8resultEffectiveDateTo TO $Request/ns 1:PS8/Effe
ﬁ MAP $PS_TEMPLATEPSSresultiDTypes with Advanced Options TO $Reque:
ﬁ MAP $PS_TEMPLATEPSSresult/Roles TO $Requestins1:PS8Roles
&5 maP $PS_TEMPLATEPSS/resultRoles|2] TO $Requestins1:PS8/Roles[2]
i Execute N
[=}- After Execute Actions
ﬁ MAF $ResponsePS8 TO $Output/PSS

Creating PeopleSoft Services

This section describes how to use the Integration ManagerTM Connect for PeopleSoft to create a
PeopleSoft Service component to connect to PeopleSoft and listen for events. As part of the process of
creating a PeopleSoft Service, you can select an existing PeopleSoft connection resource, or you can
create a new one. If you create the connection beforehand, it is available for use by any PeopleSoft
Services in the current project. If you have not already created at least one PeopleSoft connection
resource in the current project, you will be prompted to do so when you try to create a PeopleSoft Service.

NOTE: You can still create a PeopleSoft Service without first creating a connection resource, but you
won’t be able to use any debug features that depend on a live connection.

> To Create a New PeopleSoft Service:
1 Seclect File > New > xObject. The New xObject dialog box is displayed.

NOTE: Alternatively, under Service in the Integration Manager Navigator pane (Explorer view),
you can highlight PeopleSoft Service, click the right mouse button, then select New.

2 Select the Process/Service tab.
3 Double-click on “PeopleSoft Service.”

If you have not previously defined a connection resource, you are prompted to do so now (see
“Creating Connection Resources” on page 31).
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If you have already defined a connection resource, the “Create a New PeopleSoft Service” Wizard
is displayed.
|

This wizard will guide you through the creation of an PeopleSoft Service. Please enter a name and,
optionally, 2 description for the Component. The name will appear in the Composer Detail Pane and in
chaice lists when you are prom pted for objects in Composer. The name may notcontain the characters: 107"
<= | Names are case insensitive (8. MyObjecthame is the same as myobjectname)

Mame:

PeonleSoffileSenvics

Deszcription:

urpose:

Input:
utput:
emarks

| |[ Next > ][ Cancel

4 Type a Name for the new PeopleSoft Service.

5 Optionally, type Description text.

6 Seclect Next. The XML Input/Output Message Property Info panel of the New PeopleSoft Service
Wizard is displayed.

Create a New PeopleSoft Service x|

Specify one or more *ML Templates to help design Input bo this Com ponent or Web Service andonly one 1o
design Cutput. The sample XML Documents ineach Template are design time aids to help you build Action
Models for the component. The samples are not actually used at runtime after deployment to your application
server. The |dentifier is fiied and represents the name usedto refer to the XML Document during com ponert
exgcution. Selecting System {AN ¥} allows you to use an empty template (2. acceptany cocumentas Input).

nput Message

Part ‘ Template Category Template MName

Input Jostt COUNTRY

utpLt Message

Part ‘ Template Category Template Mame

Output | isystem} AN}

[ < Back “ Next > ” Cancel ]

7 Specify the Input and Output templates as follows:

+ Type a name for the template under Part if you wish the name to appear in the DOM as
something other than “Input”

+ Select a Template Category if it is different than the default category.
+ Select a Template Name from the list of XML templates in the selected Template Category.

+ To add additional input XML templates, click Add, then choose a Template Category and
Template Name for each.

+ Toremove an input XML template, select an entry and click Delete.

8 Seclect an XML template for use as an Output DOM using the procedure described in the previous
step.

NOTE: You can specify an input or output XML template that contains no structure by selecting
{System}{ANY?} as the Input or Output template. For more information, see “Creating an Output
Document without Using a Template” in the Novell Integration Manager User’s Guide.

9 Select Next. The Temp and Fault XML Template panel is displayed.
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10

11

12

13

14

15

Create a New PeopleSoft Service x|

Specify one or more Temp and Fault XML Tem plates 1o help design tem porary parts and fault handling far this
ComponentorWeb Senvice. Use Temp documents for creating intfermediate results or holding values for
reference. Specify XML Templates 1o serve as Fault documents to be passed back o clients underermor
conditions.

Temp Message

Part Template Category Template Name

Al

II

Delete

Fault Message

Part | Template Category Template MName
_SystemFault |{System} D {Fault} D add
[ < Back ][ Next > ][ Cancel ]

If desired, specify a template to be used as a scratch pad under the “Temp Message” pane of the
dialog box. This can be useful if you need a place to hold values that will be used temporarily
during the execution of your component. Select a Template Category if it is different than the
default category. Then select a Template Name from the list of XML templates in the selected
Template Category.

Under the “Fault Message” pane, select an XML template to be used to pass back to clients when
an error condition occurs.

To add additional input XML templates, click Add and choose a Template Category and
Template Name for each. Repeat as many times as desired. To remove an input XML template,
select an entry and click Delete.

Select Next. The Connection Info panel of the Create a New PeopleSoft Service wizard is
displayed.

Create a New PeopleSoft Service x|

Specify which Connection you wish to use for this Com ponent or Service. To change any connection
parameters, you must change them in the Connection Resounce object or create a new Connection Resource
of the same type with different parameters

Connection IPsﬂFiIaService1 Test
Poliing Location I | |
File Masl: |
Synchronization Type I B

Responseiick Directory I | |

Error Directory I | |

Poll Interval I

Processing Mode I B

Thread Limit I

Select a PeopleSoft File, HTTP, or TCP Service connection from the Connection list. The
Connection list displays the names of the PeopleSoft connection resources that have been defined
in this project.

[ < Back ][ Finish ” Cancel ‘

Select Finish. The component is created and the PeopleSoft Service Editor is displayed. The
features of this window are identical to the features described in “About the PeopleSoft Component
Editor Window” on page 39. The following sections describe the steps required to create a
PeopleSoft Service Action.
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Creating PeopleSoft Service Actions

50

You can create all the normal Integration Manager actions in the Action Model of your PeopleSoft
Service (e.g., XML Map, Function, Log, Send Mail). In addition, you can create a PeopleSoft Service
Request action.

The PeopleSoft Service Request action is similar to a Switch action (see “The Switch Action” in the in
the Novell Integration Manager User’s Guide). A Switch action allows program control to branch to a
block of actions based on a match between an input value and a Case value. In a PeopleSoft Service
Request, Integration Manager receives a DOM, and compares a series of cases against the DOM. If an
exact match occurs between the DOM and a case, execution branches to the actions listed underneath the
case in the Action model. Cases are tested in the order listed; and once a match is found, execution of the
match logic precludes execution of any other logic in the PeopleSoft Service Request.

> To Create a PeopleSoft Service Request Action

1 In the Action Model, right-click on PeopleSoft Service Request:

=} PsfiFileService

[ERE copleSoft Service Request: ServiceRequest
b

Default Mew Action
Eclit Action... %
Dizable Action

Toggle Brealpoint

Cut
Copy

Delete...
Find...
Find Mext

Replace...

2 Sclect Edit Action. The Service Request dialog box is displayed.
o

Search far function(s). Use asterisk (* ) for wildcard seanches. After selecting a function, press the Mapping button 1o
select fields for mapping and create & boolean expression for the case by pressing the expression bution

Functions:

=3 Componert Interfaces

[+ Messages .
=3 Componert Interfaces(RPC)
Rt
A
=Y

3 In the Function tree, click on the plus (+) sign to the left of the Messages node to expand the tree

view for that node.
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=2 Messages

3]

[+

[

[

[+

[

[

[+

[

[

[+

[

[

[+

[

[

[+

[

£ ACCOUNT_CHARTFIELD_FULLSYNC VERSION
fi ACCOUNT_CHARTFIELD_S'YNC.VERSION_1
£ ACTION_REASON_FULLSYNC VERSION_1
£ ACTION_REASON_SYNC VERSION_1

F ACTUAL_TIVE_ADD.VERSION_1

Fi ACTUAL_TIME_BATCH_ADD YERSION_1
£ APE_NDUSTRY_FULLSYNC VERSION_1
f APE_INDUSTRY_SYNC VERSION_1

£ APPLICANTIDCHANGE VERSION_1

£ APPLICANTIDDELETE VERSION_1

Foe AWARD_GRANT_ISSUE VERSION_1

£ BANK_FULLS¥NC VERSION_1

£ BANK_SYNC VERSION_1

f BUDGET _JOBCODE_FULLSYMNC VERSION_1
£ BUDGET_POSITION_FULLSYNC VERSION_1
£ BUS_UNIT_FS_FULLSYNC VERSION_1

F BUS_UNIT_FS_SYNC.VERSION_1

£ BUS_UNIT_GL_FULLSYNC VERSION_1

Right-click on the message name that you want to use for input and select Add Case, or double-
click on the message name.

=2 Messages

[+

Foo A-7T7T TTTTTTID_FULLS YNC . VERSION
D_SYMNC VERSION_1
LSYMNC VERSIOM_1
MCVERSION_1

fen Add Caze...
e ACTION_REASON_

The Adapter Service Request dialog box is displayed. This dialog box is similar to the PeopleSoft
Request dialog box (see “Creating Actions in the Component Editor” on page 40).

& adapter service Request

Selectfields for mapping and NEP diplay options

" Service Recuest ][ |[ Cage Expression |

x|

[¥] Filter Request

Service Request Tree

- O FieldTypes
- [ MsgData

“ Cancel ]

Select or deselect Filter Request, as desired. Filter Request is selected by default. If deselected, the
tree will be disabled and greyed (no longer editable), indicating that a default schema configuration
will be used. If selected, you can customize the structure of the request document by selecting the

nodes to be included in the request document.

Expand the nodes of the Service Request Tree by clicking on the plus signs to the left of the nodes.

Select the elements that you want to include in the Service Request document by selecting or
deselecting the check boxes in the node tree. Some nodes are greyed out (disabled). This is because
the document schema determines the nodes that you can edit.
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8 If the Service Response tab is enabled (this depends on the Synchronization Type setting in the
Connection resource), click the Service Response tab at the top of the dialog box to bring the
Service Response document pane forward. This pane shows a tree view of the Response document,
similar to the one shown for the Request document. The same user interface features that applied to
the Request document pane apply to the Response document pane.

9 Visit all of the nodes in the Response document tree and customize the settings as desired.

10 Click the Case Expression tab at the top of the dialog box to bring the Case Expression pane
forward. This pane provides an Expression Builder that you use to build a case expression.

x
Selectfields for mapping and NEF diplay options
[Sel vice Request |[ | Case Expression ]
Variables: FunctiohsMethods: Cperators:
5 <> ServiceRequest [#l Custom Scripts = Math
=} <> ns1T:ACCOUNT_CH. [+ Document [=l Relational
4 xminsns1 [+ ECMAScript = Logical
=] <> FieldTypes [+ Extended ECMAScript (=] String
< xmins [+ LDAP Script
[} <> GL_ACCOUI [+ PeopleSoft Service
< class
[} <> SETID
[} <> ACCOur

erviceRequest XPath"ns 1 ACCOUNT_CHARTF ELD_FULLSYMNCIFieldTypesiGL_ACCOUNT_TE
ACCOUNT @type')

[(validate || ok [ cancel |
11 Type the static string values or the ECMAScript expressions that will be checked against the input
DOM.
12 Select the OK button. The Service Request dialog box is displayed.
x

Search for function(s). Use asterisk (* ) for wildcard searches. After selecting a function, press the Mapping button to
select fields for mapping andcreate a boolean expression far the case by pressing the expression button.

Functions Mapping

£)-C Messages OUNT_CHARTFIELD_FULLEYNC VERSION_T g .|
[ fe ACCOUNT_CHARTFIELD_FULLSYMC.WERSION -
[ fe ACCOUNT_CHARTFIELD_SYHC . VERSION_1

[ foe ACTION_REASOM_FULLSYNC.VERSION_1 bl
[ foe ACTION_REASON_S'YNC VERSION_1

[ f ACTUAL_TIME_ADD.VERSION_1 v
[ f ACTUAL_TIME_BATCH_ADD.VERSION_1 @,

) o APE_INDUSTRY _FULLSYNC.VERSION_1
3} f APE_INDUSTRY_S'YNC.VERSION_1

[} f APPLICANTIDCHANGE VERSION_1

(3} f« APPLICANTIDDELETE WERSION_1

[} f AWARD_GRANT_JSSUE WVERSION_1

[} f BANIK_FULLSYNC.VERSION_1

[ foe BANK_SYNC.VERSION_1

[#} £ BUDGET_JOBCODE_FULLSYNC VERSION_1
(3} £« BUDGET_POSITION_FULLSYNC VERSION_1
[} f BUS_UNIT_FS_FULLSYNC.VERSION_1

[} f BUS_UNIT_FS_SYNC VERSION_1

[} f BUS_UNIT_GL_FULLSYNC.VERSION_1

[<] |

13 To add another case, repeat Step 3 through Step 12. The cases are listed from top to bottom in the
order in which they are evaluated. Each Case value will be checked in turn, in the order you list
them.

+ For optimal performance, list the most likely matches first.

+ You can change the order in which the cases are listed by clicking on the name of a case, then
clicking the up or down triangle icons.
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*

To edit a case, select the name of the case, then press the Mapping button. You can also select
the name of the case, then select the Expression Builder button.

14 When you have finished adding cases, select OK. The Service Request dialog box closes and a new
action appears in the Action Model of your component. The Native Environment Pane changes to
show the Request and Response (if the Synchronization Type is set to REQUEST RESPONSE in
the Connection resource) tabs along with tree views of the request and response documents.

_io(x
mo -8 x
Novell
) Process (BB ncririosenicer |
9 () senice
F C/ﬁ o @ Input Data Ox (s
i Senite O <>Pes Da
@) JD. Edwards Senict xminsns!  |urniwaysoftware acapterpeoplesoftei | [E-<
@) MS Service (3} <> companent [USER_PROFILE
& Lawson Service <> hey [BusinessAnalyst
2 Oracle Applications { [5< > Transaction
mm CrECe Application: ¢ (2} > GL_ACCOUNT_TEL
B FeonissniEEvice & class
B7) SAP Service <>SETID
S Reauest pata 0 x
E = DSEABRERON
Jan - PsiFileService
Jan 5 ?E» PeopleSoft Service Fiequest
-
) Default
fig) CALL ADAPTER raiseResourceException( "Eror process|
MAP ADAPTER. getRequestDocument( TO $Request.
@ output bnm ax b gethieqt 0 N
f(x) CALL ADAPTER setResponseDocument( Input )
| @ Froect | Registies <
Feb2,2005 111742 Al
B
| cuten [ ] [ oo i
FSE\V\CEREQueSllACCOUNY_CHARTF\ELD_FULLSVNC

15 In the Action Model, add actions to be performed to each case to create the desired business logic.

*

To map a node of the Input document to a node in the Request document, drag a node from the
Input pane and drop it on a node in the Request tab of the Native Environment pane. This
automatically creates a new XML Map Action in the Action Model.

To map a node of the Response document to a node in the Output document, drag a node from
the Response tab of the Native Environment pane and drop it on a node in the Output pane. This
automatically creates a new XML Map Action in the Action Model. You can cut, copy, or delete
the actions once they appear in the Action Model pane.

When all of the Actions for a case have been evaluated, Integration Manager sets the Service
Response DOM.

The final case in the Action model is always labeled Default. This case is generated
automatically and cannot be removed. Actions placed under Default are executed if and only if
the none of the other cases are matched. While you are not required to place actions under
Default, it is good programming practice to have at least some kind of fallback logic for the
Default case, even if it’s only a Log action or a Raise Error action.

The Request and Response document displays for Service Requests work similarly to the
displays for Requests (see “Request and Response Documents™ on page 45).

Managing Deployed PeopleSoft Services

Once a project containing PeopleSoft Services has been deployed (see “Deploying Your Project” in the
Novell Integration Manager User s Guide), the Listener objects actively listen for messages each time
you start your server. To manually start and stop these services you need to use the PeopleSoft Services
Console. This browser-based console allows you to see the list of PeopleSoft Services, the status of each
service (running or not running), the running tally (Count) of messages received, other administrative
information, and a Start/Stop button.
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> To display the PeopleSoft Services Console:

1

Make sure that you have installed the Integration Manager Enterprise Server to your application
server (see the Novell Integration Manager Installation Guide) and that your application server is
running.

Start the Integration Manager Enterprise Server (for example, if you are using the JBoss application
server, you would use a Web browser to access http://localhost:8080/exteNdComposer). A dialog
box for entering the application server administrator ID and password is displayed.

Type your administrator ID and password, then select OK. The Composer Server Console page is
displayed.

Scroll down the About Products list on the left side of the page until you see the link titled
“psftservice”.

¥ exteNd Composer Server Console - Mozilla Firefox: e o =] 3]
Flo Edt Wiew Go Bookmarks Tools Help
I3 @ - £33 [ tipidocaostextenaCompaserfCansole +[Q |

- EE CIEE

L]
TELNET General Properties and Settings
fiondem Wil Free Memory: 30 Mb
urs Log Level: 5
(EEm Apply Log Level
baanservice
Cache Status
ide Expressions Cached: 74
ideservice ¥Path Naodes Cached: s}
e Functions/Code Tables Cached: a
bwsin Component Types Cached: 4
Total Components Cached: 5
bwsnservice
Clear Cache
orac
oracservice Cache Tuning
psft Expression ¢ XPath Caching: & on Coff
i Component Cache Expinyg: 720
o @ Total Compaonent Cache Size: 250
shl
Apply Cache Tuning
shlservice i
| © 19962004 Nowell, Inc. 2006/02/02 11:42:10 k]
hitp: fflocalhostfexteNdComposer/PraductAbaLt jsp?PRODUCT=psftservice
A

Select the “psftservice” link. A page is displayed that provides information (e.g., version, license
number, copyright) about the Connect. It also displays a Console button.

Select the Console button. The PeopleSoft Service console page is displayed. This page lists any
PeopleSoft Services that have been deployed.

&) peopleSoft Console - Mozilla Firefox o ] 4

exteNd Composer

Novell.

PeopleSoft Listener Groups
Service Desc Bunning StartfStop InUse Msgs Rewd Status
psftfile.PeftFileServicel PsftFileService! true Stapl false 0 Ready

Refresh Console |

f Done Vs

7 To stop a PeopleSoft Service, select the appropriate Stop button (the button will then change to

Start).
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NOTE: If messages are being handled by a service at the time of the Stop command, there may

be some delay before the service actually exits. Select the Refresh button periodically until the

“Running” column of the console says No for the service.

> To undeploy a PeopleSoft Service:

1

Make sure that you have installed the Integration Manager Enterprise Server to your application
server (see the Novell Integration Manager Installation Guide) and that your application server is

running.

Start the Integration Manager Enterprise Server (for example, if you are using the JBoss application
server, you would use a Web browser to access http://localhost:8080/exteNdComposer). A dialog

box for entering the application server administrator ID and password is displayed.

Login as an administrator (File > Login).
Select the Deployment icon (| 8)from the toolbar.
Select Deployed Objects:

@ localhost: 80 jb JHDI Tree Manage UR

Deployed Objed Configure deployed objects far a server
o a SilverMastersn

Expand the database containing the deployed objects that you want to manage:

Deployed Ohjects:
= a SilverMasters0

g Express

% exteMdComposer_sar

g P=ftFileServiced _ear

Select the object that you want to undeploy.
Select the Undeploy button.

ECMAScript Extensions

See Appendix A to this guide for a list of ECMAScript extension methods that can be used with the

PeopleSoft Connect.

Creating a PeopleSoft Component
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ECMAScript Methods

The J2EE Connector framework of the Integration Manager Connect for PeopleSoft implements a
number of ECMAScript extension methods that are available for use through the Expression Builder
(which is available in Function Actions and elsewhere). You will find the methods listed in the
Functions/Methods pane of the Expression Builder

x

Variables: FunctiohsMethods: Operators:
[#- <> Input [#l Custom Scripts [+}-Math
[#}-<< > Output [+ Document [+}-Relational
[t} <> SystemFault | (| ECMAScript [+}-Logical
[+}-=<> PROJECT [+} Extended ECMAScript [+}-String
[t} > Repeat Aliases  [+| LDAP Script
[+}-=< > Node Aliases | -} PeopleSoft

[=}-Adapter Interface Methods

getAdapterType()
[=}-Java Connector Methods

getAdapterMetaData(String asType)
getConnectionMetaData(String asType)

[>] X X

Validate || 0K || Cancel

Hover-help is available for each method.

For more information on working with the Expression Builder, see the Scripting chapter of the
Integration Manager User s Guide.

Adapter Interface Methods

getAdapterType()

This method calls returns the adapter type name (e.g., “psft”) as a String.

Syntax:
getAdapterType()
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Connection Interface Methods
The following CCI API metadata-wrapped methods are published through the Expression Builder.

getAdapterMetaData()

This method wraps calls on the javax.resource.cci.ResourceAdapterMetaData class.

Syntax:
getAdapterMetaData(String parameter)

Parameter Description

NAME Returns the name of the adapter (e.g., “iWay JCA
adapter”).

EXECUTEWITHI Returns true if the implementation class for the

Interaction interface implements public Record
execute method; otherwise the method returns
false.

EXECUTEWITHIO Returns true if the implementation class for the
Interaction interface implements public boolean
execute method; otherwise the method returns

false.
VENDOR Returns the name of the vendor that has provided
the resource adapter (e.g., “iWay Software, Inc.”.
VERSION Returns the version of the resource adapter (e.g.,
“5.5").

INTERACTIONSPECS Returns the fully-qualified name of the
InteractionSpec type supported by this resource
adapter (e.g., “com.ibi.afjca.WAFInteractionSpec”).

SPECVERSION Returns a string representation of the version of the
connector architecture specification that is
supported by the resource adapter (e.g., “1.0”).

LOCALTX Returns true if the resource adapter implements the
LocalTransaction interface and supports local
transaction demarcation on the underlying EIS
(Enterprise Information System) instance through
the LocalTransaction interface.

getConnectionMetaData()
This method wraps calls on the javax.resource.cci.ConnectionMetaData class.

Syntax:
getConnectionMetaData(String parameter)

Parameter Description

EISPRODUCTNAME Returns the product name of the underlying EIS
instance (e.g., “PeopleSoft”).

EISPRODUCTVERSION Returns product version of the underlying EIS
instance (e.g., “Supports PeopleSoft 8.”).
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Parameter Description

USER Returns the user name for an active connection
as known to the underlying EIS instance.

Additional Methods

The following ECMA-wrapped methods are not displayed by the Expression Builder user interface, but
you can use them in the Expression Builder by typing them directly into expressions.

getWarnings()
Returns line separated list of javax.resource.cci.ResourceWarning for the
javax.resource.cci.Interaction.
clearWarnings()
Calls javax.resource.cci.Interaction.clearWarnings ().
getLastError()

Returns last error, such as a javax.resource.ResourceException.

ECMAScript Methods 59



60 Novell Integration Manager 6 Connect for PeopleSoft User's Guide



Using Component Interfaces

This appendix describes how to create new component interfaces—and how to modify existing
component interfaces—for use with PeopleSoft 8 and Novell Integration Manager.

After generating and securing a component interface as described in this Appendix, you must generate its
API, as described in “Building PeopleSoft Component Interface API Classes” on page 24 in this guide.

NOTE: This appendix is not a substitute for PeopleSoft documentation. For complete and up-to-date
information about PeopleSoft integration APIs, see the PeopleSoft Online Library for your PeopleSoft
system.

How to Create a New Component Interface

> To create a component interface:
1  Launch the PeopleSoft Application Designer.

2 Choose New from the File menu.

The New dialog box opens.

~] Application Designer - Untitled =] x|
Flle Edit View Insert Build Debug Tools Go Favaorites Window Help

REEEEREEEE

N ]

Business Intedink

-
Business Process — Cancsl

Component
Component Interface

F evelopment

Eegin validation of record definitions for default version of message LOCATION_SYNC.
Mo erors found,
End validation of record definitions for default version of message LOCATION_SYMC.

4]

AT Buld_}_Find Gbject References Jl, Uparade \ Results ), Validate /”
Ready S D

3 Select Component Interface and click OK. The Select Source Component for Component Interface
dialog opens.

Using Component Interfaces 61



~J Application Designer - Untitled . -=] x|

Fie Edt Wiew Insert Buld Debug Tools Go Favorites ‘indom Help

Di=l8l8] & &(=e = 8jE

25 Unttled

Select source Component for Component Interface - x|
Obiect Typs: [ Component 2

- Selection Cancel |
Name [106_cobe_teL Project [ Projects |
New Search
Dessipton [

ittt 40 Makets >
Objects matching selection criteria: @
Hame [ Market_| Desciption [ B

IPE_FLAN_TABLE GEL  IPE Plan Table

IPE_STEP_TABLE GEL  IPE Step Table

JBCMP_THP_DEPT GBL  Mass Change Dept

JBCMP_TMP_STAT GEL  Mass Change Stats =l
JOBCODE_HAZRDS TEL  GBL  Job Code Hazard: Table

JOBCODE_TASK_TABLE GBL Job Code Task Table
E_TEL G Ji Tat

bl

GBI Jab Data
GBL  AddNonEmplopee
_DATA GBL  Applant His

JOB_DATA_CONCUR GBL  Add Concurent Job =l

3084 objeet(s] found

Hveveiapment

Begin validation of record definiions for default version of message LOCATION_SYNC.
Ma errors found,
End validaion of record definitions for defal version of message LOCATION_SYNC.

> [ Buld_J_Find Ofjeet Refererces._ Ugrate J\ Results ), Ualidate

Ready. T

4 Select the component to use as a basis for a Component Interface.
5 Click the Select button.The Application Designer dialog opens.

~J Application Designer - Untitled =181x
Fis Fdt Yiew Insert Fuld Debug Took o Favorites Window Language Help

mEEEEREEED E

application Designer i x|

Do you wark to defeult the propettes based on the
undetling Companent definiion, JOB_CODE_TBL?
(12312)

Yes Mo Explain

Begin vaidation of recard defintios for defauit version of message LOCATION_SYNC.
Mo erors found
End walidalion of record definiions for default version of message LOCATION_SYNC.

AT\ Buid J\_Find Ohject References_J\ Upgrade  Resuls ), Validate

Ready I T

6 To create the component interface without displaying individual properties for one-by-one
selection, click No. Otherwise, to expose component properties manually, click No and drag the
relevant fields from the left pane to the right pane.

NOTE: If the component interface is large, it is recommended that you expose the component
properties manually as just described.

See your PeopleBooks documentation for additional options and their meanings.
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] Application Designer - Untitled - [Component Interfacel (Component Interface)] =18 x|

E]Fle Edt View Insert Buld Debug Tools Go Favorites Window Help =l@] ]
eEIEETE 2|
JOB_CODE_TEL (Componert] | Name Fecod Field Read 0... | Comment
| ] JOBCODE _TEL (Tablel - St [=
©-F Seroll-Level 0 -8 GETKEYS
JOBCODE_TBL [Table & SETID JOBCODE_TBL SETID
HR_LBL_WRK Derive: @ JOBOODE J0BCODE_TBL JOBCODE
DERIVED [Derived) £ FINDKEYS
Seral - Level 1 Primary & SETID JOBCODE_TBL SETID
£ B Serol-Level 1 Piimary @ JOBCODE JOBCODE_TBL JOBCODE
JOBCODE _TBL [T o DESCA JOBCODE_TBL DESCR
FUNCLIB_HR [Der @ GYT_OCC_SERIES JOBCODE_TBL GYT_OCC_SERL.,
DERIVED_IC_GBL o GUT_DFFICIAL_DESCR JOBCODE_TBL GYT_OFFICIAL .
EG_IC_WRKD [De &3 CREATEKEYS
DERIED_EG [De & SETID JOBCODE_TBL SETID
GYT_DERNED_LI o J0BOODE JOBCODE_TBL JOBCODE
DERIVED_GYT (D @ PROPERTIES
HR_LBL_WRKDe| £ METHODS
DERIVED_POPUF & Cancel
EXCH_RT_WRK [ & Cieate
Scroll-Level 2 i & Find
Serol-Level 2 i & Get
Soroll-Level 2 P & Save
Scroll-Level 2 i
Serol-Level 2 i
Soroll-Level 2 P
K| | i}
Begin valdalion of record defiritions for default version of message LOCATION_SYH. -
Mo errs foun
End validation of recard defintions for defauit version of messags LOCATION_SYNC.
A0 | Build Fird Objsct References Uparade A\ Resulls A Validate
Ready I | !

7 Designate the methods you wish to use in this Component Interface as described in the next
procedure.

Methods

The standard methods created for a component interface are:

o Create
o Find

s Get

s Save

Only those methods actually implemented in the underlying component are available. For example, if the
underlying component does not contain Add capabilities, Create is not available.

> To designate Methods to use in the Component Interface

1  Open the Component Interface Properties dialog box (continuing from the procedure described

previously).
‘Application Designer - Untitled - [Component Inte =X
FIFlz Edt Yiew Insert Buld Debug Tools Go Favorites Window Help =18 x]|
WEEEEEEEEN =
[y 105_CODE_TBL (Component] [ Name: Fecord [ Field [Read 0... [ Commer 4]
) Untitled () JOBCODE_TEL (Table) - 51 [ @ UNTITLED
B soroli-Leveld =148 GETKEYS
JOBCODE _TBL (Tsble L@ SETID JOBCODE_TBL SETID
HR_LBL WAK Derive | ..dw JOBCODE JOBCOPE_TEL JIBCODE
i
€_TBL SETID
General - Standard Methads | £ TBL JOBCODE
€_TBL DESCR
e e £_TBL GYT_OCC_SERI
I¥ Cieale €_TBL GYT_OFFICIAL_
I¥ Find
£_TEL SETID
7 Get £_TBL JOBCODE
[V Savs
€_TBL SETID ¥
£_TEL JIBCODE v
B_BU_Vw
B_BU_\w SETCNTRLVALUE e
€_TBL
£_TEL EFFDT
€_TBL EFF_STATUS
£_TEL DESCR
E_TBL DESCRSHORT
£_TEL JOB_FUNCTION
E_TBL SETID_SALARY
£_TBL SAL_ADMIN_PL.
E_TBL GRADE v
£_TBL STEP
E_TBL MANAGER_LEVEL
£_TBL SURVEY_SALARY
E_TBL SURVEY_IOB_L.
4 Devetopment [£H Upgrase_| £ TBL UNIDN_CD
kI I e [IRRFNCY M [~
Biegin valdaion of record defintions for defeul versian of message LOCATION_SYNC. -
o errors foun
End validation of recard definiions for default version of message LOCATION_SYNE:
[ Buia_J\_Tird Object References i Upgrate J Resufs , Validate

Ready [ |

Using Component Interfaces 63



2 Select the desired methods.

Properties

You may add properties from the records in the component view. You can also delete a property in the
component interface that you do not want to expose. You can rename properties by clicking the property
and then, clicking again until you can type a new name. If you rename a property, it can be referenced in
the component interface only by the new name, not by the underlying component name.

Properties may have various icons adjacent to them. For example, EMPLID has an icon indicating that it
is a key field from the underlying record. NAME has an icon indicating that it is an alternate key field
from the underlying record. For a complete list of property icons, see the PeopleBooks documentation.

You can right-click both panes to select various functions to perform depending on which pane is active.
For a complete list of functions, see the PeopleBooks documentation.

Securing a Component Interface

You must set up security for the component interface before you can begin testing.

Configuring Component Interface Security for PeopleSoft Version 8.1x

The following procedure describes how to configure component interface security for PeopleSoft
Version 8.1 in 2- and 3-tier mode.

> To configure component interface security:

Maintain Security
File Edit Yiew Go Favorites | Use Setup Process Help

| | |;| | | = Iy Profile | | | | | |
E ¥ x it E Forgot My Password Il S A i ‘

User Profiles 3
Administer Personalizations

Delete User Profile

Rales 3

Role Save As

Delete Role

Permission Lists General
Permission List Save As Pages
Delete Permission Lisk PeopleTools

Process
Sign-on Times
Component Interface
Message Monitar
‘Web Libraries
Query

Mass Change
Other Settings
Audit

*+ v v v v vRldv v v v~

1 From the Use menu, select Permission Lists, Component Interface, and then click Update/Display.
Before Security can be set, the Permission List(s) must be identified.
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Maintain Security - Use - Permission Lists

File Edit “iew Go Favoites Use Setup Process Help

sl EE = =N EE N E E +./|«.,1||

Update/Display -- Permission Lists

Permission List:

o]

Cancel |
Permission List Description =
ALLPORTL onal] Portal Pe _ Seach |
CPAET000 Application
CPAM1000 Application Messaging Admin, Detail |
CPBN1000 Benefits
CPCO1000 Callsbarative Apps Admin
CPCO1500 Administer Self Service Use Query I
CPEB1000 eBenefits
ornia Cimai )

= NewQuey |

Mare matching entries were found than can be displayed.

[HET7050H | [PST | j
[For Help, click Help Topics on the Help Menu 115,289 I

2 Select the relevant Permission list.

NOTE: For more information on Permission Lists, see the PeopleBooks documentation.

The following pane opens.

Maintain Security - Use - Permission Lists

File Edit Miew Go Favoites Use Setup Process Help

8g|x| 8= S EEEEE +«./+g\

General | Pages | PeopleTaak | Frocess | Signon Times Compenent Interface | Message Monitor | Wb Libraries | Guery | Mass Change | Links | Audit |

Permission List ALLPORTL =
Description: [Portal] Portal Permissions

Name Edit -

AMOUNTINC_JPN Edit

CITY_TBL_ITA Edit

JOBCODE| = Edit

MSGSTATUSSUMMARY Edit

SALARY_GHADE Edit

Click On This Row To Enter Data

| |
[HET70SUN  [Component Interiace [PST  [Update/Display
‘Fur Help. click Help Topics on the Help Menu. ‘ |

.\.\LI;

3 Insert the new component interface that you created.
4 Click Edit.

NOTE: When you select the component interface, all available methods appear, including user-

defined methods. This enables you to specify whether this particular Permission List must have Full
or Partial Access.

5 Select the desired level of access.
6 Click OK.

In the following example, the ALLPORTL Permission List has Full Access to all methods.
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Maintain Security - Use - Permission Lists
Eile Edit Wiew Go Favortes Use Setup Process Help

Blelx| =0e) sl == S| S Hell])

Ganelall Pagesl Peop\eToolsl Plocessl Sign-on Times  Companent Interace | Message Munitorl b L\blariesl Query | Mass Changel Links | Audit |

Permission List: ALLPORTL =
Description: [Pantal] Partal Permissions
Mame [ F dit T.l
PR I[] Component Interface Permissions [ x]
CITY_TBL_
e Joecue
MSGSTAT!  [jyahod *Method Access I Cancel
Full Access (All]
SALARY € [Get Full Access =] e — -
Click On T Create Full Access
Save Full Access Ho Access (All)
Cancel Full Access
Find Full Access
-
-
| | »
Service=Field Change I [HET705UN  [Companent Interface PST  [lpdate/Display 7
Rieady Hatzosun [ [ ] [

Configuring Component Interface Security for PeopleSoft Version 8.4+
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The following sample procedure describes how to configure component interface security for PeopleSoft

Version 8.4 or higher.

> To configure interface security:

SETE

| 3 EMPLOYEE - Microsoft Internet Explorer
Fle Edt view Faverites Tods Help

SEak » & - @ [ A | Dearch [alFavariees Hrsory | B S B - H [ @

acivess B hetpsffsdervia EFALLT

=

B Accounts Payable
P eSettiements
b Asset Management
b Banking
b Cash Management
b Deal Management
P Risk Mananement
B AT and Infrastat
P Commitment Contral
b General Ledger
b allocations
P Statutary Reports
b Data Exchanges
P SetUp FinancialsfSupply Ghain
b Define Integration Rules FDM
P Government Resource Directary
b Background Pracesses
B Wiorklist
P Tree Mananer
b Reporting Tools
~ PeopleTools
~ Security
b User Profiles
 Permissions & Roles
- Permission Lists
- Gopy Permission Lists
- Delete Permission Lists
- Roles
- CopyRoles
- Delete Roles
- Execute Rale Rules
b Directory
b Security Objects
b Quer Security
- Review Security Information
b Utilies
P workfiow
B Portal
P Search Engine
b Fersanalization
b Process Scheduler
P Cube Manager
B Application Engine

I

@l 1 "PT_PERMISSIONS_ROLES","http, . PL IB_PT_NAY.ISCRIPTL.FieldFormula 15c

1 Expand PeopleTools, Security, User Profiles, and Permissions & Roles and then, click Permission

Lists.
2 (Click Search.
The Permissions List search window opens.

Novell Integration Manager 6 Connect for PeopleSoft User's Guide

|4 Internet



Fle Edit view Favorites Tooks Help

= Back.

D @ 4| Qearch [HFavortes

Hstory | By S 2 ] @

Accress [ hecpuiisdsrv1a bt comibspl

fpSIEMPLOYEE [ERPIC/MAINTAIN_SECURITY.ACCESS_CHTRL_LISTX.GBL

P Tree Manager
P Reporting Tools
v PeapleTanls

~ Security

P User Profiles
= Permissions & Roles

- Gopy Permission Lists
- Delete Permission Lists
- Roles

= Copy Roles
- Delete Roles
- Execute Role Rules

[ewr window | Heln

Permission Lists
Ener any information you have and elick Search. Leave fields blank far a list of all values

{ Find an Existing Value \_Add a New Yalug |

Search by: [Pemission List =] begins witn|

Search | Advanced Search

P Directory

b Security Objects
b Query Security
- Revigw Security

Information

b Utilities

b workllow

b Portal

I Search Engine
4

[Search (al+1)
Search Results

Onlythe first 300 results can be displayed. Enter more infarmation above and search again to reduce the number of search results.

View All 1108 ot200 [3] Last

b Process Scheduler
P Cube Wanager

I Application Engine

I Integration Broker

P CTI Configuration

b Archive Data

b Transiations

b EDI Manager

P Mass Changes

- Change My Passward
Y ——

- My System Profile

[Permission List Description
AEAE1000

AEPNLS AEPNLS: clane of ALLPNLS
ALLPAGES  ALLPAGES

ALLPORTL Al Portal

AMPNLE (blanky

AMEYSTEM  (blank)

APPNLS (olanky

APPERVR Gan start application server
BOPNLSA (olank)

BDPNLSS (blank)

BIPNLS Billing Fanels

CPAET0D0  Application

CPEO1000  Enterprise Objects

{&] javascript: submitAction_main{document. main, #1CRowD');

| [ 4 mternet

Select the relevant Permission List.

The Permissions List window opens.

rosoft Internet Explorer =& x|
ew Favortes  Took  Help |
24 | Dusearch [EFavorices isory | By- S W B 9
7nddrassIWhtlu‘Msdsrv14.|b\‘cum/DSD/DS/EMPLO\‘EE#ERPﬂ(/MAINTAIN,SECURIW.ACCESS,CNTRL,LISTX‘GBL =] @8 ‘

m.
o & |

b Tree Manager

I» Reporting Taols

= PeapleTaols

¥ Security

b User Profiles

~ Permissions & Roles

- Copy Permission Lists
= Delete Permission Lists

MewWindow | Help

Fages | PeopleTools / Process | SignonTimes | [P

{General Y,
ALLPAGES

Description: [ALLPAGES
Permission List General

Permission List:

b Security Objects

P Query Security

- Review Security
Inforrnation

b Utilities

b waorkflow

b Portal

b Search Engine

b Personalization

b Process Scheduler

b Cube Manager

b Application Engine

b Integration Braker

b CTI Configuration

b Archive Data

b Translations

b EDI Manager

P Mass Changes

- Change My Password

- My Persanalizations

- My System Proiil

- Raoles
- CopvRoles Navigator Homepage: [FeaToR
- Delete Roles.
- Execute Role Rules ¥ can start Server?
b Direct
eson I Allow Password to be Emailed?

Time-out Minutes

¥ Never Time-out
 Specific Time-out (minutes)

Clrstumto Seoh) (iEhxtin List) (+EPrevious mList)

Do) Boaan) ()

General | Pages | PeopleTools | Process | Sign-on Times | Companent Interfaces | Messaae Monitor | Weh Libraries | Personalizations | Guery | Mass ¢

<4l

‘&] one

The Compone

| mternet

4 Click the right arrow next to the Sign-on Times tab.

nt Interfaces tab becomes available.
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68

crosoft Internet Explorer

View Favorites Tools  Help

SIS

o | B & ol 12 (] @

14, ‘AIN_SECURITY.ACCESS_CNTRL_LISTX GBL

=l o |

b Tree Manager
P Reporting Tools
VVP;;:J:I,W‘E [ Sign-on Times_ Component Interfaces \_Messape Monitor | Web Libraries | [¥)
b User Profiles P
ermission List:
< Permissions & Rales ALLPAGES
Description ALLPAGES
- Copy Permission Lists
. [Component Interfaces
- Cony Rales Name Edit
- Delete Roles AP_PCIOB_ROST Edit F=
- Execute Role Rules .
B Diretony AP_PCJOB_RGST2 Edit [+ -]
b Security Objects AR_CONVERSATION_AGENT Edit ] [=]
P Query Security
- Review Securit AR_CREDIT_AGENT Edit ] [=]
Information AR_ITEM_AGENT Edit M=
b utilities
b Worklow AUC_BID_CONTACT_CI Edit =]
b portal AUC_CREATE_CLOME_CI Edit +| -
b Search Engine - - - - 20
P Personalization AUC_CREATE_PO Edit =]
E ET;;;ZE;;Z?“‘E' AUC_PAGELET_PREF_CI Edit =]
b Application Engine AUC_YNDR_ID_CI Edit 4 -]
b Integration Broker & =
b CTi Configuration ARCULEARRRTC] i cale
b Archive Data BDG_CNTRL_EW_NTFY Edit -]
b Transiations
+|[=
b EDI Manager BDG_CNTRL_NOTIFY Edit -]
b Mass Changes BD_ACCT_PER_LOOKUR Edit -]
- Change My Password =
- by Perconalizations EELAREEELEE Edit =]
- Wy Sestern Profile IEDJ\SSET Edit +| -1 |
|«

Newriindour | He\gj

€ (]

5 Click the Component Interfaces tab.

6 Click the + button to add a new row to the Component Interfaces list.

© meemet

Eh- - o

Search Favories Hlslow‘ Mal  Sze Pt Edi Discuss  AM

Back o Step  Refiesh  Home

Agdress [ ] rp://iscrv14.bicom?pep./ps/EMPLOYEE /ERP/c/MAINTAIN_SECURITY.ACCE SS_CNTRL_LIST. GBL

o

=

b Reporting Tools
v PecpleTools
- Seeurity (4] /"Sign-on Times _y Component Interfaces Y_Mgssage Monitar | Weh Libraries | [)
b User Prafiles
v Permissions & Roles Permission List: ALLPAGES
Cony Pemmission Lists Description: ALLPAGES
- Delete Permission Lists
- Boles
- ConyRoles
- Dolele Roles Hame Edit
- Execute Role Rules AP_PCIOB_ROST Edit
b Directory
AP_PCIOB_RQST? Edit
D Security Objects - - ot
b Query Security AR_CONVERSATION_AGENT Edit
- Beview Security
Beview Secyi AR_CREDIT_AGENT Edit
Information
b Utiiities I QJ Edit
b worknow
b Portal AUC_BID_CONTAGT_CI Edit
P gearch Enaine AUC_CREATE_CLONE_CI Edit
D Personalization
D Process Scheduler AUC_CREATE_PO Ecit
D Cube Manager AUC_PAGELET_FREF_CI Edit
b Application Engine
b ntegration Broker AUC_VNDR_D_CI Edit
b CTI Configuration
b Archive Data AECSNEARRRCC] Ed]
D Translations BDG_CNTRL_EW_NTFY Edt
D EDI Manager
b Mass Changes BDG_GNTRL_NOTIFY Edt
- Change by Pas sword BD_ACCT_FER_LOOKUP Eot
- My Personalizations
M Sretom Frofile BD_ANALYSIS_DB Edit
=4l |

hew Window | Help j

of?

&

7 Type the component interface name and click Edit.
This example uses component interface AR ITEM_AGENT.
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[_[=]x]

[ Permission Lists - Microsoft Intemet Explorer
Fe Edi ¥iew Favoites Toos Help |ﬁ
.2 Q & 2 9 o

Back  Fowad | Stop  Aefesh  Home | Seach Favorles Histop | Mal  See  Pint  Edf  Discwss  AM
Adchess [ ] hitp://izdars1 4bi.com/psp/ps/EMPLOYEE/EFP/o/MAINTAIN_SECURITY.ACCESS_CNTRL_LISTRGBL

D Reporting Toals 2]

< PeopleTools
= Seourity Component Interface Permissions

BN

€ Home

DlewWindow | Heln

I User Profiles
= Permissions & Roles AR_ITEM_AGENT

FUTASGESE (A ]

Cony Permission Lists component interrace
- Delete Permission Lists jssi
- Foles

Loy Role: Method “Method Access
- Camy Roles et Method Access
Full Access - No Access (All)

- Delete Roles Get

- Execute Role Rules
¥ Directary Create Full Access -
b Security Objects |
b ooy Satunty Save Full Access
- Review Security Cancel Full Actess 2

Infarmation
b Utilities Find Full Access ~
b Warkdlow
b Pottal 0K Cancel
b Search Engine
b Personalization
b Process Scheduler
b Cube Manager
I Application Engine
P Integration Braker
b T Configuration
b Archive Data
b Translations
I EDI Manager
b Mass Changes
- Ghanae My Passwird
- iy Personalizations
- iy Systerm Profile

3] [ [ [ Intemet

8 Select the desired access from the drop-down lists.
9 Click OK.

Zj Permission Lists - Microsoft Internet Explorer

Il File Edit View Favorites Tools  Help
GBak - = - () [0 A | Qoearch Gyravortes (HHstory | By Sl 5 (] D

Address Iﬁ hktp:fisdsry14.ibi. comipsp/ps [EMPLOYEE/ERPfc/MATNTAIN_SECURITY. ACCESS_CNTRL_LISTH.GBL

—

P Tree Manager |
P Reporting Tools
= PeopleTools

- Security

b User Profiles

Copy Permission Lists
- Delete Permission Lists
- Rales
- CopyRoles
- Dalele Roles
- Execute Role Rules

b Directory

b Security Objects

P Query security
- Review Security

Information

b Utlities

b winrkiow

b Portal

b Search Engine

b Persanalization

b Process Scheduler

b Cube Manager

b Applicalion Engine

b Integration Broker

b CTI Configuration

b Archive Data

b Translations

e Dowe) (@it seann) iErctintiot) (EPvsiss nist) Bran)

- Chanae My Passwoid General | Pages | PeogleTools | Process | Sign-on Times | ¢ Interfaces | Message Monitor | Weh Libraries | i \QuemMja;:‘

5

- My Personalizations

= My Systern Profile
-4 |

[ [ e mternet

a
10 Scroll down to the bottom of the Component Interface Permissions window and click Save.

Testing a Component Interface

The iWay Adapter for PeopleSoft 8 uses PeopleSoft metadata and component interfaces, therefore, it can
accommodate new or modified component interfaces. The adapter makes no assumptions about
component interfaces except that they are logical and valid. Therefore, each component interface must be

tested before being used as a source for the adapter.
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If changes are made to the underlying application by the user or by means of a PeopleSoft upgrade, and
these changes invalidate a component interface, the user must repair the invalid component interface

before the adapter uses it.

> Totesta component interface:

1

The Component Interface Tester dialog box opens.

In Application Designer, select Test Component Interface from the Tools menu.
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Click the Component Interface Tester dialog box to bring it to the foreground, if required.
To test the component interface using the Find method, click Find.

The Component Interface Tester - Find Results window opens, displaying all of the possible entries
for the underlying component. If there are more than 300 entries, a message appears.
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4 Sclect a field in the left pane of the Find Results window.

5 To display the relevant data for that particular key, click Get Selected.
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If the security settings permit, you can change the values in the individual fields.
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To test the component interface using the Get method, enter the existing key(s).
Click Get Existing.

This returns the exposed properties for the key that you entered.

You can change values if Update access has been specified.
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8 To test the component interface using the Create method, enter all required key values.
9 Click Create New.

When you enter valid values in ‘Create’ keys, the JOBCODE Data Display window opens after the
Table name is expanded with default data in place.
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You can change fields at this point. Changes are validated against the component’s underlying
business logic.

10 After you finish making changes, right-click the top item in the pane.
11 Click Save to save your changes.

The keys used to create the record can be used with the Get method for viewing data.

The data that were added can be viewed in the PeopleSoft Component as shown in the following
example.
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Notice the Effective Date as one of the default values.

You have finished testing the component interface. Before using the component interface, you must
generate its API, as described at “Building PeopleSoft Component Interface API Classes” on page 24.
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